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Interface Overview

Ganz CORTROL Client is a dedicated application for viewing live and browsing the recorded contents of
connected Ganz CORTROL servers. It also includes advanced features such as video and snapshot export, alert
monitoring, PTZ and digital PTZ control, among others. As Ganz CORTROL Client is a unified interface for all
Ganz CORTROL editions, some of the features described in this document may only be present if you are connected
to Ganz CORTROL Global server and are not available for other server types (for example, the video wall feature).
We recommend that end users and CCTV station operators become acquainted with this document in order to
understand the application interface and work out some personal usage strategies.
Important: Ganz CORTROL server and Ganz CORTROL Client application major versions must match.
Example: Ganz CORTROL Client having version 1.3.0 will be unable to connect to servers having versions
1.2.0 or 1.4.0.
Maintenance versions within the same major version (e.g., 1.3.0 and 1.3.1) are compatible but we still
recommend that you match the software versions exactly for best performance.
For best user experience, display resolution of 1280x720 pixels or higher is recommended for Ganz
CORTROL Client application, alongside with 512MB onboard video memory per display.

General
The Ganz CORTROL Client interface is mostly intuitive. Elements are manipulated using left mouse button (click,
drag and drop) and mouse wheel (e.g., to change digits in timestamps). Right clicks (pop-up menus of all sorts)
have been eliminated to facilitate the Ganz CORTROL Client application for usage with touch displays.
The application appearance can be changed to accommodate individual users' needs and preferences. Overlay
elements are adjusted in the Application settings, and component colours - using the Themes tool. These settings,
alongside with local resources (layouts and sequences) and the list of servers can be saved into a file for further
import on other workstations.
The main application functionalities are available via tabs. Visibility of these tabs and certain interface elements can
be controlled for each Ganz CORTROL Client application instance using the Ganz CORTROL Client Administration
Tool, which is available via main menu View -> Administration Tool.
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Ganz CORTROL Client interface
The Ganz CORTROL Client application window title displays window name, display number, computer station
name, and also video wall title and display number.
Most elements (buttons, menu items, overlay elements) have tooltips - text hints that appear when you position the
mouse cursor over the item and hold it for a moment. Tooltips are enabled by default and can be turned OFF
via application settings.

Application Windows
The main (primary) application window displays contents provided by server or servers in different
modes, depending on the tab selected. All secondary windows only display live channels, without any supplementary
tabs, menus or panels. Please refer to the Interface Elements section of this document for detailed information about
all Ganz CORTROL Client panels, buttons and other controls.
The Ganz CORTROL Client application is always running in the single instance mode, meaning that it should only
be launched once. Additional (secondary) windows can be opened on all additional displays.

Upper Panel: Tabs
The upper panel contains tabs that allow you to quickly switch between the main software functionalities. Some
tabs (e.g., Live, Playback) are always present while other ones (Access Control, LPR etc.) only appear when the
related feature or contents is available on one of the connected servers. Tabs are only present for the main
application window.

Upper Right: Connections and Main Menu
The Connection button opens a dialog box with the server list. Next to it, there is the main application menu, which
contains items for the Ganz CORTROL Client tune-up and additional wizards.
Below the main menu, there is a button for multi-display setup and another one for managing the current
display contents.

Left: Resources
This section displays resources from the connected servers: layouts (including layout templates and sequences),
©2019. CBC AMERICAS, Corp.. All Rights Reserved.
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channels, maps, and user buttons. The resources panel can be hidden by clicking the << arrows in its upper right
corner to free up more display space for the contents.
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Interface Elements

This topic covers Ganz CORTROL Client interface elements in more details.
Application elements and sections can be configured to be hidden via Ganz CORTROL Client administration
tool. By default, all functionality is available based on the Ganz CORTROL server configuration and license
limitations.

Main Viewing Area
The main (central) viewing section displays contents provided by the connected servers. The type of the contents
depends upon the selected tab: this may be live video, several types of playback, data from external services
etc. Please see the corresponding sections of this document for detailed information about each mode.

Top Right: Window Controls

Standard window controls: go fullscreen, minimize, restore and close
From this panel, the Ganz CORTROL Client application window can be:
opened in fullscreen mode
minimised to taskbar
maximised/restored to default size
closed
To toggle fullscreen , F11 can also be used. This is one of the default keyboard shortcuts: to change the action hotkey,
go to main menu Edit >> Command Mapping.

Upper Panel: Tabs

Ganz CORTROL Client application upper panel with tabs
The upper panel contains tabs that allow you to quickly switch between main software functionality. The following
tabs may be available, depending on the software version and configuration:
Live: real-time video streams with PTZ controls, data overlay and instant playback
Playback: recorded video stream investigation
Sequence: advanced analysis of the recorded video streams
Smart Search: quickly find the target scene using motion search
Alerts: generated alerts and information level messages
Library: exported video clips and snapshots
Video Wall*: video wall display configuration
Reports: create diagrams and heatmaps based on the collected metadata
LPR**: investigation of the license plate recognition results
FR**: investigation of the face recognition results
Data Sources**: investigation of textual data received from configured external data providers
*The tab only appears when Ganz CORTROL Global server connections are present, video walls exist in the Ganz
CORTROL Global configuration and the used user account has sufficient privileges assigned via Ganz CORTROL
Console.
**The tab only appears if corresponding service is supported by Ganz CORTROL license, the service has been set up
via Ganz CORTROL Console and the used user account has sufficient privileges.
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When all tabs do not fit in - either because of smaller screen size/resolution or due to decreased application window
size - tab items are collapsed to icons. Tooltips will provide clues

Upper Panel: Server Connections

The Ganz CORTROL Client application Connection button on the upper panel
The Connection button opens server connection setup window and also displays the number of currently configured
servers.

Upper Right: Main Menu

Ganz CORTROL Client application main menu
This section contains the main application menu items.
File
Exit: close the Ganz CORTROL Client application
Edit
Settings: application settings
Command mapping: keyboard shortcuts
Theme: application appearance management
View: operation modes and application view management
Time presentation: choose between local, UTC or specific server time zone
Operation modes:
Always on top
Exclusivity mode
Locked application
Tools: utilities related to Ganz CORTROL Client application management and other tools
Import Settings: load application settings from file
Export Settings: save current application settings to file
Archive Backup Wizard
Administration Tool
Help
User Guide: opens the Ganz CORTROL Client application user manual
About: about Ganz CORTROL Client
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Left: Resources

The Resources panel of the Ganz CORTROL Client application
This section displays resources from the connected servers: layouts, channels and maps loaded from configured
servers. If visual grouping has been configured for the target server, the resources will be arranged into expandable
lists. Visual groups (looking as folders) can be dragged and dropped onto the viewing area whole.
The panel can be docked to the left by pressing the << arrows in the top part of the panel, and restored back by
clicking the >> arrows; individual resource lists can also be collapsed and restored by clicking the subsection name.
Search field in the upper panel part allows you to filter the resources based on the entered text.
Search: global resource search
Layouts
Layouts, layout templates and layout sequences
Local resources: stored on Ganz CORTROL Client machine
Server resources: loaded from connected server(s) (shared layouts and server-side layout
templates)
Channels: per server or mixed, if Merge resources option has been enabled in the server connection
properties
Unavailable channels are marked red
Maps*: e-maps, per server or mixed
User Buttons*: software buttons that perform actions, associated with them via Event&Action scenarios;
per server or mixed
*Some resources may be unavailable for certain software editions.
Channels, maps and user buttons can also be grouped independently through the Visual Groups functionality of
Ganz CORTROL Console.
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About

The information about currently running software can be viewed using the local computer in following way: in Ganz
CORTROL Client, go to the main menu, click Help and select About.

About Ganz CORTROL Client
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License Limitations

Please note that, as Ganz CORTROL Client application is a unified interface for all Ganz CORTROL editions, some
features described further in this document may not be available for certain Ganz CORTROL server versions.
When the Ganz CORTROL Client is connected to a server that is operating with a free license, the
following limitations apply:
each Ganz CORTROL Client application can be connected to a single free server at a time
each free server can have no more than one simultaneous Ganz CORTROL Client connection
some types of the resources will be not available (e.g., video walls, maps, user buttons, external services,
data sources)
Some features, like video wall, will also be unavailable with Ganz CORTROL Server servers. Ganz CORTROL Client
applications connected to Ganz CORTROL Global server(s) will provide full functionality.

©2019. CBC AMERICAS, Corp.. All Rights Reserved.
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Server Connections

The main purpose of the Ganz CORTROL Client application is to display the contents of the local and/or remote
server(s). By default, Ganz CORTROL Client contains a local server connection entry when it is installed together
with the server.
You can connect to multiple Ganz CORTROL servers of different editions within the local network or over the
Internet, using built-in Ganz CORTROL users or AD/LDAP domain users (pre-configured on the server side). In the
Ganz CORTROL Global system, you simply need to enter the central management server address, and all the Ganz
CORTROL Recorder and mirroring server connections are established automatically. If the Ganz CORTROL Global
server goes offline, your Ganz CORTROL Client application will be redirected automatically to the mirror, if it exists;
if not, the Ganz CORTROL Recorder connections will still be available (without enterprise features provided by Ganz
CORTROL Global server).
In the Application settings, it is possible to set up automatic logout after a certain period of user inactivity. If this
setting is enabled, all the servers will be disconnected from if there is no user activity in the application interface;
default inactivity period is 15 (fifteen) minutes.
The list of servers can be saved into a file for further distribution on other workstations via main menu Tools >
Import/Export Settings. This, you can enter the list of server connections with all required user accounts, save it,
and then import the file on other client machines. All settings are stored, except from the user passwords - for
security reasons, the passwords are not kept. You will only have to enter them once after importing the server list.
The Ganz CORTROL Server software edition allows a maximum of 1 (one) simultaneous connection to the
server; Ganz CORTROL Client can also only be connected to one Ganz CORTROL Server server at once. Other
software editions have no limitations in this regard.
One concurrent connection to a server is maintained at a time to optimize the network traffic. For certain use
cases, you may want to create multiple connections to the same server with different credentials (having
different permission sets) without saving the passwords and ask each user to choose his profile and enter his
password when starting his session. To ensure that no person uses previous user's session, there is an auto
logout option after certain period of inactivity, which can be enabled in the application settings.
To connect to a remote server via local or public IP or hostname, follow the steps below.
Select the Connection section in the upper panel to bring up the dialog box.
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Open the Connection section from the upper panel
Click the Remove button in the upper-right-hand corner to delete the existing (which, by default, is the local one)
server connection. Click the + Add server button to create a new server connection and fill the connection
parameters. Alternatively, choose Edit to adjust existing server connection settings.

©2019. CBC AMERICAS, Corp.. All Rights Reserved.
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Add new server dialog box
The table below contains details about the available parameters.
Setting

Description

Default
value

Server Title

User-defined server name

Server #N

Server IP Address

Local/Internet IP address or host name of the target server

localhost

Server Port

TCP port for remote connection

60554

User Name

User account name for remote connection

admin

User Password

Password for the provided user profile

[empty]

Domain

AD/LDAP domain, if applicable

[empty]

Multicast Mode

Accept multicast streams from the target server (must be enabled on server
side)

Disabled

Merge Resources

Do not display the source server for accessed resources; shuffle server
resources (for multiple servers)

Disabled

Click Save when you have finished. The server connection created will appear in the item list and Ganz CORTROL
Client will attempt to establish the connection immediately. Click Disconnect if you do wish to start working with the
target server later.
For you to be able to use the multicast mode, it must be enabled on the server side via Ganz CORTROL
Console. Also, multicast traffic must be allowed on all the network equipment on the way from your server to
the Ganz CORTROL Client.
©2019. CBC AMERICAS, Corp.. All Rights Reserved.
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Available connection list
Select a server by clicking it in the list and click Connect in order to (re-)establish a connection with the selected
server. Server resources will automatically appear in the left hand panel.
If you chose not to store the password, you will be asked for it every time you re-connect to the target server. In
that dialog box, you will also have an option to change the user domain - you can use a domain that is different from
the one used in the current Windows logon session.
If your user account does not have a privilege to log into Ganz CORTROL Client application without entering login
reason, you will be also asked to provide a justification for this server session. The entered text will be logged in the
server audit log. This is an additional security feature and it can be disabled by adding the corresponding user
permission in Ganz CORTROL Console, under Administration profile in the user account settings.

Specify the password to establish the connection with the target server
Click Disconnect in this same dialog box to log out from the selected server.

©2019. CBC AMERICAS, Corp.. All Rights Reserved.
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Application Settings

Ganz CORTROL Client settings let you define the appearance and behaviour of the application, as well as pre-define
some defaults, such as video and snapshot export defaults.
Application settings are reachable via the main menu by clicking Edit -> Settings, and these cover all configurable
options of the program GUI. Note that parameters here are defined for the whole application and cannot be set
separately for application instances and/or individual layouts, channels etc.
These settings can be saved into a separate configuration file and later imported in any other Ganz CORTROL Client
application, including application instances on other workstations. The export/import procedure is described at the
end of this topic.

General
General settings like the application language, automatic logout, exclusivity mode parameters etc. can be found here.

General section of application settings
The table below contains a detailed description for each setting.
Setting

Description

Default Value

Language

Choose language for the application interface from the list of available
localizations (requires application restart); will affect both Ganz CORTROL
Client and Ganz CORTROL Console applications, if installed

Language set
during
installation,
English by default

Application
startup
mode

Enable the application to be started in the specified mode
(locked/exclusive/both/none); regular = no special mode

Regular

Interactive
user
idleness
action

Override or allow OS screensaver

System Settings

Auto logout
after user
inactivity

If enabled, all the servers will be automatically disconnected after a certain
period of user idleness

Disabled

User
idleness
timeout

Time period in minutes, after which the auto logout will be executed

15 minutes
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Exclusive
mode*

Defines if exclusivity mode is applied to all monitors or currently opened
application instances only

Opened screens
only

Exclusive
mode
password

User-defined password for unlocking exclusivity and locked application modes

[none]

Enable
watchdog

Turn ON application behaviour monitoring: Ganz CORTROL Client watchdog
will restart the application if it freezes or hangs during operation or on startup
(it is highly recommended to keep the watchdog enabled)

Enabled

Show
Enable application update notifications from connected servers
update
notifications

Enabled

*Exclusivity mode settings:
All Monitors mode will force fill all displays with child Ganz CORTROL Client application instances upon
enabling exclusivity mode
Opened screens only mode will still allow background application/OS access via displays where no Ganz
CORTROL Client is launched
Important: Ganz CORTROL server and Ganz CORTROL Client application major versions must match.
Example: Ganz CORTROL Client having version 1.3.0 will be unable to connect to servers having versions
1.2.0 or 1.4.0.
Maintenance versions within the same major version (e.g., 1.3.0 and 1.3.1) are compatible but we still
recommend that you match the software versions exactly for best performance.
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Usability
This section contains settings related to the application controls and interaction with the application elements:
different playback modes, DPTZ etc.
Setting

Description

Default Value

Show
tooltips

Show hints when hovering over some element with the mouse cursor

Enabled

Maintain
original
aspect ratio

Keep original picture proportions; when OFF, image will be stretched to fill in the
viewport (this setting can be overridden for each individual viewport)

Disabled

Pause
decoding for
background
channels

If enabled, decoding for background channels will be terminated when one of the
channels is maximised*

Disabled

Default
DPTZ mode

Choose how digital PTZ behaves by default: region mode or PTZ emulation

Region

Interaction
with map
markers

Choose how you want to activate map markers (channels, links to other maps etc.): Double click
with a single click or a double click

Prefer
substream
for archive
playback

Use recorded substream for playback, if available; this setting is good for low
bandwidth connections

Disabled

Instant
playback
default
duration

Default timeline size for the instant playback mode, in seconds

300

Instant
playback
rewind

Default amount of time in seconds to "jump back" when switching from live to
instant playback mode

60

Pause instant If enabled, instant playback will be paused after switching from live view
playback by
default

Disabled

Timeline
presentation
in playback
mode

Selected
channel plus
a summary
timeline

Choose whether you want to see the timeline for the currently selected channel
only, optionally with an additional timeline containing all displayed streams'
summary, or a separate timeline track for each channel present in the layout

*If decoding is stopped for the background channels, a certain amount of time is required to restart the decoding
after the foreground channel has been minimised back to its viewport. Thus, enabling this option will decrease CPU
utilisation but increase the delay in presenting the rest of the channels when switching back from the maximised
channel view.
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Viewport Overlays
Viewport overlays are items displayed on top of the video stream. These are miscellaneous controls, buttons,
statistics and metadata.

Viewport overlay section of application settings
You can assign separate settings to each overlay item. Note that, regardless of application settings, some of the
controls are not displayed if corresponding action is not available for the target device, e.g., the Instant Playback
control item is not shown if there is no recorded archive. The following options are available for each control:
Always ON: always display the overlay element
ON if selected: only display the element when the viewport is selected (yellow frame appears)
Always OFF: never display the element
For your convenience, visual overlay items are previewed on the left side of each setting.
Setting
General

Description
Items displayed in the upper-left-hand corner:
Title (device or resource name)
Close (a control allowing to close the current stream and free the
viewport)
Lock (a control allowing to lock the stream in its current
viewport, making it immune to pop-ups)
User buttons

Display
Data displayed in the bottom-left-hand corner of the viewport:
status section
Writing On Disk (recording status)
Motion Detection (motion presence)
Video Resolution (picture size)
Video Compression (stream video codec)
Video FPS (stream frame rate)
Video Bitrate (data amount, bits per second)
©2019. CBC AMERICAS, Corp.. All Rights Reserved.
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Display
controls
section

Controls displayed in the bottom-right-hand corner of the viewport:
Instant Playback (switch mode)
PTZ Toggle (PTZ and preset controls ON/OFF)
Digital PTZ Toggle (DPTZ ON/OFF)
Motion Detection Grid Toggle (MD grid ON/OFF)
Substream Mode Toggle (switch displayed stream:
main/sub/auto)
Maintain Aspect Ratio Toggle (auto/fill/original)
Export Snapshot (save frame to library)
Add User Bookmark (create bookmark and add it to the
timeline)
Input Audio Toggle (incoming audio ON/OFF)
Output Audio Toggle (a press-to-speak audio OUT control)
Toggle Notifications Pane (ON/OFF)
Toggle Notifications Pane (panel presence)

ON if selected, except
for PTZ controls

Digital PTZ
Controls

DPTZ and dewarp manipulation tools (OFF by default; when ON, Picturein-Picture mode and DPTZ toolbar are ON by default):
Digital PTZ Controls
Zoom slider (DPTZ zoom IN/OUT)
Picture in Picture (small preview window in the top left viewport
corner when zoomed IN)
Digital PTZ Toolbar (advanced DPTZ controls: presets, dewarp
modes)

OFF by default

PTZ controls
section

Pan, tilt and zoom controls:
PTZ Controls (PTZ functionality ON/OFF regardless of
HUD/classic sphere presence)*
PTZ HUD (Heads Up Display, virtual PTZ sphere)
Iris Slider (iris open/close)
Focus Slider (manual focus control)
Zoom Slider (zoom IN/OUT)
PTZ Toolbar (advanced PTZ controls: presets, tours)
Classic PTZ Overlay (old style virtual PTZ sphere, visual
alternative to HUD mode)

ON if selected

Motion
detection
section

Show motion detector grid overlay (for software-side MD and only some
device-side MD)

Always OFF

VCA

Server-side video analytics metadata overlaying video stream:
Always ON
Zones (detection areas)
Counters (indicators associated with VCA rules)
Objects (all detected entities)
Non-Alarmed objects (those not having triggered any VCA rules)
Speed (object speed)
Height (object height)
Area (object size, approximate area it takes)
Class (object type according to defined internal classification)
Identifier (internal VCA engine ID for each object)

These settings are stored in the Ganz CORTROL Client application configuration file and are preserved when the
application is closed and reopened.
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VCA tips:
if you only want to see the objects that have triggered some rule(s), set Objects to ON and NonAlarmed Objects to OFF
object measurements (height, speed, area) highly depend on VCA calibration on the server side
*If you set PTZ Controls (Manipulation) to Always OFF, you will have to use the PTZ Toggle overlay control
in order to enable PTZ functionality in live view. If you disable PTZ toggle overlay button, too, user will have
no access to PTZ from the viewport. In other words, PTZ Controls setting affects actual PTZ manipulation
availability regardless of presence of the visual controls (HUD or classic PTZ sphere overlay).

Library
Library is the folder containing all video files and snapshots exported via Ganz CORTROL Client application, as well
as related jobs - for example, file copying to another location, including CD/DVD. This section allows you to define
the library path and some other settings.

Library section of application settings
Define the default location for snapshots and exported video to be saved to. The original default location is:
C:\Users\<Windows_User>\Documents\Ganz CORTROL Client
The only additional setting here is Show "Save file" dialog box: if enabled, the dialog box will pop up every time you
export a snapshot or a video file, allowing you to select a custom file destination every time.

Snapshot Export
Ganz CORTROL Client supports both single channel and multichannel snapshots (the latter is available from
Playback mode only). Naming settings here affect both types; for multi-frame snapshots, the channel name
$(StreamTitle) will be replaced with the word Multichannel.

Snapshots Export section of application settings
Set file properties for the exported snapshots. The table below contains a detailed description for each setting.
©2019. CBC AMERICAS, Corp.. All Rights Reserved.
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Setting

Description

Default
Value

Snapshot file name

File name for exported JPEG snapshots; $(variables) are used for automatic
timestamps and other text macros

Set of
variables

JPEG quality

Picture quality, 1 (worst) to 100 (best)

60

Subtitles

Hard merged subtitles with configurable font; click the Properties button to
select the subtitle contents and appearance

Enabled

Always use snapshot
export settings

If enabled, the settings above will be used for all exported snapshots;
otherwise, the user will be prompted for these every time

Enabled

Video Export
Set the default video export settings here. All the file types will be playable by the Ganz CORTROL Portable Player
application so it is up to you, which ones to select; the settings affect file size and subtitle type availability. Also,
some of the formats are required for certain features to work: for instance, POS data overlay is only supported as
hard subtitles for MKV format with VP8 compression.
Each format has its pros and cons:
AVI, original format: quickest, small file size, no subtitles or extras
AVI + JPEG compression: allows choosing full/quarter resolution, hard subtitles supported; requires
more time, large file size
MP4: small file size, soft subtitles
MKV, original format: extra small file size
MKV + VP8 compression: medium file size, additional options available (motion blur, time lapse, data
overlay), any subs, takes most time
If you wish to embed the external textual data with the video, use MKV export format with VP8
compression. MKV format also exclusively allows to export video in time lapse mode.

Video Export section of application settings
The table below contains a detailed description of each setting.
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Setting

Description

Default
Value

Video file name

File name for the exported video; $(variables) are used for the automatic
timestamps

Set of
variables

Video output file
type

Choose between AVI, MP4, MKV and frame series.

AVI

Video
compression

Keep the original compression or use an output-specific compressor.

Original
when
possible

Resolution

Choose between full and quarter original resolution if regular compression is used

Full

Time lapse
(MKV only)

Time (in seconds) to be fitted into one second of output video

60

Include external
data (MKV+VP8
only)

If enabled, the data source (text) overlay will be embedded with the exported video

Disabled

Subtitles

Enable hard merged or soft subtitles for the exported video (availability may
depend on the format and compression); click the Properties button to set the
subtitle format and colour

Disabled

Always use
archive export
settings

If enabled, the settings above will be used for all the exported video clips, otherwise
the user will be prompted for these every time

Enabled

Sounds
Here, you can enable/disable sounds and choose sounds settings for the server notifications.
When event sending to the clients is configured on the server side, it is merely the sound index number (1-10) that is
set, and different notification sounds can be defined for each Ganz CORTROL Client application. It is also possible
to disable sound for all or any individual notification.

Sound settings for notifications
Options:
unmark the Enable sounds setting to disable audio notifications (enabled by default)
for every audio notification (1-10) it is possible to:
set the standard notification sound (default), or
disable sound (select None), or
choose your own .wav or .mp3 file to be played.
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Use the Play/Pause buttons on the right to verify that the audio file sounds as desired.
Note that, once you set a custom sound or no sound for some notification, the default sound will become
unavailable.
When an audio notification is triggered during system operation, there is no option to stop it - the whole audio
file will be played back. Keep this in mind when choosing custom sounds. Default audio notifications are quite
short.

Import and Export Application Settings
Ganz CORTROL Client application preferences can be saved and exported as a file, so that they can later be used on
other workstations running Ganz CORTROL Client, or restored on the same workstation after re-installing the
software. When importing, make sure that the Ganz CORTROL Client version on the target PC is the same or newer.
It is possible to handle the following settings:
Server connections: the list of server addresses, ports and user names, as well as connection properties
Application settings: all appearance and usability settings defined under main menu View >
Application settings plus keyboard shortcuts (see exceptions below)
Local resources: local channel layouts and also layout sequences
The following settings are NOT exported:
paths: video export library and sounds
application themes (export available via themes tool)
administration tool preferences
window settings (multidisplay setup)
To export your preferences, go to the main menu in the top right corner, and choose Tools > Export Settings. A
separate dialog box will pop up.

Enter target file name and path, and choose what settings should be exported
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In the export dialog box, choose the destination folder for the *.lxm file. Below, select what settings will be exported;
by default, all of them are chosen. You can save the settings partially, for example, export the list of server
connections into a separate file. When ready, hit the Export button. After the export is complete, you will get a
confirmation; and, you will get a warning in case the target file cannot be created (e.g., not enough user permissions
to write to the specified location). In the latter case, select a different folder and try again.
The import procedure is very similar: go to the main menu Tools > Import Settings, locate the *.lxm file, select
desired settings to be loaded and click Import. Note that the imported usability settings will overwrite the existing
ones, and the resources are imported using the following logic:
layouts and layout sequences with identical names will not be imported - currently present resources have
priority
servers with at least one different connection property (IP/host, port, domain or user name) will be
appended
For instance, when importing a list of servers with the same host name and port but different user names, all servers
will be appended to the connections with their corresponding names. Servers with identical connection properties
but different preferences (merge resources, multicast/unicast) will be ignored (not imported).
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Live View Section

Click the Live tab on the upper panel in order to switch to live video monitoring.
The panel on the left displays resources from connected servers: layout templates, layouts, channels, maps and user
buttons loaded from configured servers.
Search: global resource search
Layouts and layout templates
Local resources: stored on Ganz CORTROL Client machine
Server resources: loaded from connected server(s)
Channels: per server or mixed, if the Merge resources option has been enabled in server connection
properties
Maps*
User Buttons*
*Some resources may be unavailable for certain software editions.
Depending on the resource type, you may be able to click and/or drag items. See the relevant sections of this manual
for detailed information on how to use and manage each of these resources.

Live view in Ganz CORTROL Client
From the Layouts menu on the left, select your desired layout template and then drag and drop it into the
viewing area. Next, drag and drop channels from your desired server to the empty slots, using the Channels menu
section on the left. Layout templates can be selected either from default local templates or from server layout
templates. The latter can be created on the specified server via the Ganz CORTROL Console management
application.
You can save the current layout using the Save layout button in the upper-right-hand corner; it will become
available in the layout list on the left under the target server name. Right next to it, there is a button that can be used
to auto-detect displays, which is especially useful in multi-monitor systems.
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Live view with custom layout
Drag and drop or double-click a channel to place it onto the layout template (double-click works for the primary
window). Channels having no video stream (e.g., camera offline) are marked with red in the Channels section of the
Resources list.
Channel name is displayed in the top left corner of each viewport; the current server time will appear in the upperright-hand corner.
Click any live view to bring up additional channel-specific parameters and quick controls. Overlay preferences can
be changed via Application settings. By default, these are:
Upper-left: general viewport controls
X - close live stream and free viewport - available with or without viewport selection
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up
camera name
user buttons, if assigned
Upper-right: current time, according to the selected time presentation (server, client or UTC); you can
change it via main menu View >> Time presentation
Lower-left: stream details
recording status: X = not recording, yellow arrow = recording
motion detector status: running = motion present, standing still = no motion detected
video codec of the stream
picture resolution, abbreviated
stream frame rate, FPS
stream bitrate, KBytes/s or MBytes/s
Lower-right: controls; enabled items are highlighted yellow
instant playback (not available if there are no recordings)
PTZ toggle: PTZ HUD and bottom panel ON/OFF
DPTZ toggle
motion grid ON/OFF
incoming audio ON/OFF (if enabled and supported by camera/software integration)
audio OUT: press and hold the microphone to speak (control is present only if the feature
supported by camera/software integration)
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substream: auto/main/substream
aspect ratio (auto/stretch to fill viewport/original)
notification panel toggle
snapshot export to library
Bottom: PTZ controls
Presets
Tours
HUD (Heads Up Display) ON/OFF
Centre: PTZ HUD controls
Pan and tilt arrows
Zoom slider
Iris slider
Focus slider

Click the channel live picture to display additional options
The upper-right-hand corner of live view section contains controls for multimonitor and video wall setup.
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Viewport Overlay

Each grid cell n live view can be thought of as a 'slot' - a rectangular part of the layout - and it is called a
viewport. Every viewport can accept channel video and maps, including geo maps.
In addition to the picture itself, every viewport contains detailed information about the video stream, as well as
several quick controls and toggle buttons, including PTZ controls. These elements overlay the video stream,
meaning that the actual video does not contain them and they only exist as a part or GUI for enhanced user
interaction.
The main overlay items are briefly explained below. Also, you will find some more details on some of the controls in
the Application settings and in the Video overlay sections.

Live View

Selected viewport with active live stream
The following overlay controls are available in live view:
Upper-left: general viewport controls
X - close live stream and free viewport - available with or without viewport selection
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up
camera name
user buttons, if assigned
Upper-right: current time on the server from which the device originates
Lower-left: stream details
recording status: X = not recording, yellow arrow = recording
motion detector status: running = motion present, standing still = no motion detected
video codec of the stream
picture resolution, abbreviated
stream frame rate, FPS
stream bitrate, KBytes/s or MBytes/s
Lower-right: controls; enabled items are highlighted yellow
instant playback (not available if there are no recordings)
PTZ toggle: PTZ HUD and bottom panel ON/OFF
DPTZ toggle
motion grid ON/OFF
incoming audio ON/OFF (if enabled and supported by camera/software integration)
audio OUT: press and hold the microphone to speak (control is present only if the feature
supported by camera/software integration)
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substream: auto/main/substream
aspect ratio (auto/stretch to fill viewport/original)
notification panel toggle
snapshot export to library
Bottom: PTZ controls
Presets
Tours
HUD (Heads Up Display) ON/OFF
Centre: PTZ HUD controls
Pan and tilt arrows
Zoom slider
Iris slider
Focus slider
Live view has its own notification panel for each channel, which can be turned ON and OFF by using the
notification panel toggle control in the bottom-right-hand corner of each viewport. It contains recent stream errors,
e.g., PTZ related errors, which have occurred since the time the channel was opened for live view.

Notification panel containing errors for a disconnected stream
The overlay control set may vary depending on device capabilities and settings. For example:
if no archive is recorded for the target stream, instant playback will not be available
for PTZ-incapable cameras, PTZ toggle will be absent
substream toggle will not be displayed when device only has one stream
audio OUT will not be displayed if this feature is not supported by camera or is not implemented on
the software side etc.
Overlay elements can be modified in Application Settings, which are reachable via main menu by clicking Edit ->
Settings. Note that overlay parameters are defined for the whole application and cannot be set separately for the
application instances (windows) and/or individual devices.
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Instant Playback
Overlay elements in the instant playback mode are different from those in live view.

Instant playback in a live mode viewport
The following overlay controls are available in the instant playback mode:
Upper left:
X - close live stream and free viewport
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up and may therefore be replaced by other camera at any moment
camera name
Centre: play/pause
click to play
drag to the centre of the line to pause
drag right to go fast forward
drag left to rewind fast
release from dragging to continue normal playback
Bottom right: controls
go to specific time (keyboard shortcut: Space)
create a bookmark with current timestamp
take a snapshot
automatically export loaded footage
Bottom: timeline
use the <> arrows to adjust the loaded footage time boundaries (which, by default, are the last
five minutes)
drag right to go forward in time
drag left to go backwards in time
the vertical yellow line indicates current playback moment, drag it anywhere or click to move
along the timeline
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Sequence Explorer
Once you have selected a fragment or a set of fragments, the overlay controls in the bottom right corner of the
selection offer the following possible actions:
Magnifier button: make a new sequence out of selected fragments; use the History controls <> in the
upper panel to go back
Play button: play selected footage in archive playback mode
Video button: export video from the selected time range (no additional Set time range window is
displayed)
More detailed control and operation descriptions for the sequence explorer can be found here.

Text Overlay From Data Sources
Textual data from external data sources, if configured, will appear embedded with the live video stream.

Live video stream with text overlay

Channel Shortcuts aka Portals
Channel shortcuts, if pre-configured in Ganz CORTROL Console, appear in live view as video overlay elements.
Single-clicking these will pop up the target video channel in the same viewport.
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Shortcuts to other channels in live view
Read more about visual links in the Video overlay section.

Maps
Maps and geo maps have general overlay controls in the upper left corner:
X - close the map and free viewport - available with or without viewport selection
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be used for
map/camera pop-up
map name
Every map also has interactive markers (per-configured in Ganz CORTROL Console):
double-clicking channels* makes them pop-up in the first available viewport (either empty or the first
non-locked one)
maps* links will make the target map pop up in the same viewport
layouts* will also pop up and replace the current layout or layout sequence
double-clicking user buttons will trigger actions, which are associated with them
click a door marker to see the list of available actions
*Remember that every Ganz CORTROL Client window can be set to accept either individual map/channel pop-ups
or layout pop-ups, but not both. This can be changed in the multidisplay setup. Also, you can change the interaction
mode from double-click to single-click in the Application settings.
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Substreams

Substream is a lower resolution video used for reducing Ganz CORTROL Client PC resource usage (CPU, network)
for live view display. Also, it is possible to play back secondary streams instead of high resolution video on low
bandwidth connections. For example: main stream for recording can be set to 1920x1080 at 30fps and substream to 640x480 at 15fps, which would provide much lower load for Ganz CORTROL Client PC to display video stream.
This allows to have high quality recordings combined with the ability to view many video streams on a lowperformance Ganz CORTROL Client PC and with limited bandwidth.
Both streams are available for live view and for recording (the latter is configured via Ganz CORTROL Console). The
live stream selection is configured to Auto by default, which means automatic switching between higher/lower
resolution streams depending on the image size in order to save network and CPU resources. For instance, Ganz
CORTROL Client may show a high-resolution stream if you view one camera at a time, but if you go to 4x4 view,
Ganz CORTROL Client will automatically switch all the cameras to substreams, if they are available. In multichannel views, the application compares each viewport size to resolutions of both channel streams and decides,
which one is better, based on similarity to the output viewport size.
Ganz CORTROL Client application has the following visual indication for substreams in live view as a viewport
overlay item (bottom right):
Automatic selection between high and low resolution (based on viewport size)
High quality picture

Low quality picture (substream)
When no substream is available, the viewport overlay indicator simply will not appear at all for the target channel.
Substreams must be activated on your device via Web browser and, for some devices, this can be also done in the
stream properties in Ganz CORTROL Console. Please verify camera performance to make sure substream can be
handled by the camera along with the other enabled features: some devices tend to drop the overall FPS with
the second stream turned ON.
Most cameras provide the second stream as a primary stream image scaled to fit the low resolution. However, some
devices crop the centre of a high-resolution image to fit the smaller frame, and thus the substream picture appears
as if it were zoomed in. Keep this in mind when you are using substream for live view and especially for softwareside motion detector analysis.
If both main and secondary streams are configured for recording, the target channel will be expandable in
playback mode and will have both tracks available for playback.

Substream footage in playback mode
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Channels

All the channels from connected servers are listed in the Channels section of the Resources section on the left. If the
server connection has the Merge resources option ON, all resources will be shown together without per-server
grouping. Note that channels are displayed according to the logged user privileges.

Channels section
Channels are loaded with visual groups, if there are any; otherwise, they are simply listed under the relevant server
name. Use the Search filed above the channel list to quickly find a specific channel.
Double-click or drag and drop desired channels onto the layout viewports on the main live/playback window to view
stream contents. For secondary displays, use drag and drop method only.
When you double-click channels in live/playback view, they fill viewports in the following manner:
first, all the empty viewports are filled - from top to bottom, and from left to right;
then, the filling sequence starts again from the very first viewport.
To remove any channel from live view, click the overlay control X button next to the camera name in the upper-lefthand corner of the viewport.
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Audio

Using Ganz CORTROL Client application, you can listen to audio streams from cameras, play back recorded audio,
as well as talk back to the cameras. Recorded audio streams are also available when you export the recordings.
Two-way audio is also supported for the Ganz CORTROL Mobile application; please refer to the mobile application
user guide.
In order audio stream to be available in Ganz CORTROL Client, there are a few conditions:
the device, from which your selected channel originates, must be capable of sending/receiving audio
and this feature must be enabled and set to G.711 codec via device Web interface.
the device, from which your selected channel originates, must have audio support implemented in
Ganz CORTROL; please contact CBC AMERICAS, Corp. if you have doubts.
audio function must be enabled for the target channel via Ganz CORTROL Console, please check the
settings via Ganz CORTROL Console according to the Audio section of the Ganz CORTROL
administration user guide.
Without these, audio IN/OUT controls will not be available for the selected channel.
Make sure that the speakers and the microphone on your workstation are properly installed and are operable
in order to be able to use the audio functionality in Ganz CORTROL Client.

Live View
Audio IN/OUT toggle overlay controls are enabled by default for the live view and become available when you select
a viewport by clicking on it. You can change this preference via Ganz CORTROL Client main menu by going to Edit > Settings: you will find the related settings in the Display controls section of the Viewport overlays tab. The
available display options are: always show the overlay control, show only if the viewport is selected and disable the
overlay control.

Audio overlay controls in Live view
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By default, live audio is OFF; in order to listen to the incoming audio, click the speaker overlay control so that it
becomes yellow: if audio functionality has been enabled on the device side and in Ganz CORTROL Console, you
should be able to hear the sound coming from the target device.
In order to send some audio back to the camera, press and hold the microphone overlay control (it will also turn
yellow, indicating that reverse audio is active) to speak, then release the control when you have finished speaking.

Playback
If a channel has incoming audio recording enabled, it will be displayed in the archive playback mode. On the
timeline, recorded audio is denoted by a blue line, which slightly wider than the white line (video stream) and the
cyan line (motion).

Audio in playback mode is displayed as a wide blue line
By default, audio is muted; in order to enable it, select your desired channel simply by clicking on the picture
(viewport) and then use the speaker overlay control to turn audio ON. Note that the overlay control will only be
available if there is some recorded audio for the selected channel. Then, start playing back the recordings as usual to
play both video and audio streams. Use your Windows volume mixer to adjust the sound volume.
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PTZ

For PTZ-enabled cameras, pan, tilt and zoom controls are available both for live mode. Note that available controls
may depend on selected model and actual camera capabilities.
PTZ control is available in two flavours: HUD and classic PTZ sphere, with HUD enabled by default. Classic virtual
PTZ sphere controls can be turned ON via application settings as described below.
When two or more simultaneous PTZ command requests (either from an action or from direct user input) are
sent at the same time, PTZ priority parameter is used to decide who gains access first. When this happens,
request with a higher priority is fulfilled while request with a lower priority is delayed for ten seconds. If after
ten seconds the higher-priority action is still going on, the lower-priority action is denied PTZ access for ten
more seconds and so on.
If two users or actions with the same PTZ priority level have an access conflict, they will be both granted PTZ
access simultaneously and the order of executed PTZ commands is defined by which of the commands reaches
the device first.
Default PTZ priority for all users, including those built-in and imported, and also for all actions is equal to five
(medium priority). You can assign any user/action a higher PTZ priority (six to ten) or a lower one (four to
zero) by editing individual user/action properties in Ganz CORTROL Console. The only exception is the PTZ
tours, which by default have the lowest priority (equal to zero), which means that any user or action can
intercept PTZ control; the tour will go on after the PTZ control from a higher-priority user/action is released.
PTZ control is carried out using the HUD overlay controls or point-to-PTZ style controlling without overlay
elements; it is automatically enabled if the camera has PTZ facilities.
If HUD or classic sphere is enabled, use the overlay PTZ sphere to control camera movement: click and
hold to move the camera up/down, left/right or diagonally; additional controls allow to adjust the
camera's iris and focus, as well as to zoom IN/OUT;
If visual PTZ controls are not enabled, click anywhere on the picture to re-position the camera using
indicated point as a new picture centre (point-to-click style).
When re-positioning a PTZ camera, note that some cameras may have response delay due to heavy device
load, physical distance, network latency etc. Bear this delay in mind when using PTZ and, if necessary, release
the virtual PTZ sphere controls earlier.

Switching Between PTZ Control Styles
By default, HUD style viewport overlay controls are used for PTZ. You can change this by going to the main menu
Edit -> Settings and choosing the Viewport overlays tab -> PTZ Controls section.
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Manage PTZ overlay control settings
You can toggle between two modes:
PTZ Heads Up Display (HUD): on-screen controls overlaying video stream
Classic PTZ Overlay: virtual PTZ sphere with traditional design
One of the two modes can be selected at a time and the selected mode will be activated when you enable PTZ for the
channel of your choice. Either visual control set can be hidden by clicking the HUD button in the bottom right
corner of the viewport; in this case, PTZ can still be controlled by clicking the live video stream.

Heads Up Display (HUD) Mode
The following controls are available in HUD mode:
Pan and tilt arrows
Zoom slider*
Iris slider*
Focus slider*
Automatic focus/iris* ( button on the lower slider end)
Presets and tours
HUD (Heads Up Display) ON/OFF
*Note that some of the additional controls may be unavailable depending on the device integration and capabilities.

©2019. CBC AMERICAS, Corp.. All Rights Reserved.

38

Ganz CORTROL Client User Guide

Live view with enabled PTZ and HUD overlay controls
Use the bottom overlay menu for presets, tours and HUD ON/OFF switching.

Classic Virtual PTZ Mode
For users who prefer classic appearance of PTZ controls, an alternatively looking panel is offered. It also overlays the
live view, and is docked to the top left corner of the stream. Classic PTZ sphere has the same capabilities as the HUD
sphere. Apart from pan and tilt buttons on the sphere, zoom, focus, and iris sliders will appear, if the related
functionality is available on the device.

Live view with enabled classic PTZ sphere
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Presets
Click Presets below the picture to view the list of available presets; select any to let camera go to the selected predefined position. To save a preset, adjust the camera position using PTZ controls, then click Presets and choose
Save preset. Enter user-friendly name for your preset and pick a preset to be re-defined from existing preset list,
then click Save.
Note that PTZ presets cannot be explicitly deleted: to remove an old entry, simply replace it with a new one.

Enter preset title and choose slot

Tours
Multiple PTZ presets can be combined to create a preset tour - a series of positions for a PTZ camera to go to
through repeatedly. Each preset in a tour can be assigned a duration period of its own.
Click Tours below the picture and select Create tour to make a new sequence. Before building a tour, make sure you
have created all presets that will be used in the target tour.
Tours are stored on the server and thus are synchronised between different Ganz CORTROL Client
workstations connected to the same server.

Choose to create a new tour
Add and remove presets by double-clicking them; newly added presets will appear at the end of the tour preset
list. You can also use Search field to quickly find your desired preset, and the recycle bin icon in the upper-righthand corner allows you to remove a selected preset from the target tour.
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Create a new tour
Click a tour preset to change its delay time. By default, each preset has a pause of five seconds, and you can change
that to whatever time period you wish for the camera to continue overlooking that specific position. Next, define a
title for the target tour and enable automatic start, if desired; if you select autostart, the sequence will be launched
immediately after server start.
When you have finished, click Save to add your newly created tour to the list of available tours.

Tour options
To start a tour, click Tours and simply select the one you want from the list; to stop it, click Deactivate tour. Each
tour options - Edit and Delete - can be accessed via the
button next to the tour name.
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Digital PTZ and Dewarp

Digital PTZ
Digital pan-tilt-zoom (DPTZ) can be enabled for both PTZ and non-PTZ cameras. This feature provides image
magnification by the means of cropping and enlarging the picture, additionally using the picture-in-picture feature
to display a preview of the whole stream when the original picture is zoomed IN. While it is mostly useful for devices
without optical zoom capabilities, if you do not wish to grant some of your users PTZ control access, then DPTZ can
be also used for PTZ devices. Also, digital zoom can be used for maps.
Last used digital PTZ position is preserved when you save a layout containing a zoomed stream or map.
In order to enable DPTZ in live view or playback, select the target viewport and enable digital zoom by clicking
DPTZ toggle
button on the overlay control panel in the bottom right corner. You can also set DPTZ controls to
be visible by default via Ganz CORTROL Client main menu Edit -> Settings -> Viewport Overlays tab.

Live view with DPTZ controls enabled
An additional panel with DPTZ controls will appear below the video stream. To use DPTZ with maps, simply use
your mouse wheel to zoom IN and OUT and then drag to view different parts of the map.
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Digital PTZ Modes
Digital PTZ for video streams has two modes:
region
draw a rectangle on the video by left-clicking and dragging with your mouse
when you release the mouse, the marked area will be automatically zoomed in and a small
preview window (picture-in-picture) will appear in the upper left corner of the video
move the selection in the preview window to view different areas
use the mouse wheel either in the preview or in the original video to zoom IN/OUT
PTZ imitation
zoom IN/OUT by using your mouse wheel
when the picture is zoomed IN, a small preview window will appear in the upper left corner of
the video
move the selection in the preview window to view different areas
additionally, you can move around the video by clicking the original video as if it were a PTZ
camera (click and hold to move in that direction)
The basic difference between the two modes is the method of moving around the picture: either by drawing new
regions or with PTZ Point-to-Click imitation. By default, the region mode is enabled, and you can switch between
the two using the buttons on the right side of the DPTZ panel (RGN for region and PTZ for point-to-click mode,
correspondingly).

DPTZ Presets
Digital PTZ positions can be saved as presets and then called later at any time, just like regular PTZ presets. Use the
Presets drop-down list in the left part of the DPTZ panel for this:
to save the preset, click the arrow and click Save preset, then choose whether you want to create a new
preset or overwrite an existing one, specify the preset name and click Save
click the preset name in the list to load it
click the ... button next to the preset name and choose Remove preset to delete it
Digital PTZ presets are stored locally, on the Ganz CORTROL Client application side, and are bound to channels.
This means that, once created, DTPZ presets will be available for the target channel from the same workstation and
they cannot be shared with other application instances connected to the same server from other places.

Dewarp
For cameras with fisheye and Panomorph lenses, dewarp mode is enabled when digital PTZ is turned ON. This
feature can be used both in live view and playback mode; in order to use it, click the DPTZ toggle
control in the bottom-right-hand-corner of the viewport.

overlay

By default, region dewarp mode is turned ON: a part of the dewarped image is displayed in the viewport and
camera becomes a virtual PTZ, which can be zoomed and moved through the entire angle that fisheye camera allows.
Press left mouse button and drag to pan/tilt in corresponding direction; use the zoom slider to zoom in and out.
You can place one channel into multiple viewports on your viewport layout, enable DPTZ for all of them and then
use DPTZ to display different regions of the dewarped image. The created arrangement can be saved just as usual,
via Save Layout menu in the upper-left-hand corner: DPTZ positions will be maintained when you load the layout at
any time later.

Choose dewarp mode from the drop-down list
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If you need a larger part of the scene to be displayed in a single viewport, you can switch to a 180-degree or a 360degree panorama view using the drop-down menu, which appears in the bottom of the viewport when DPTZ is
enabled.
If you do not have a dewarped picture after enabling digital PTZ capabilities, it means that dewarp has not
been configured for the target device. In order to do this, go to Ganz CORTROL Console and adjust dewarp
settings in the channel properties; the details about setup are available in your server management
documentation.
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Instant Playback

Interactive live view mode gives you the opportunity to browse the archive right in the same viewport,
without having to switch to the playback mode. This allows you to view recent footage for selected channels, while
still having live view displayed for other devices. By default, footage is loaded for the previous five minutes and the
playback starts five seconds before the current moment; use the <> timeline boundary controls to change time
range by clicking and dragging mouse to the right (zoom in) and to the left (zoom out) of the <> arrows.
This mode is only available for channels that have recording enabled.
To enable instant archive playback, use the Play button overlay control in the bottom right corner. The channel
will automatically switch to playback mode, allowing you to select timestamps, create bookmarks and export
snapshots/video clips. To exit instant playback mode, use X in the overlay controls' bottom right section.
Instant playback mode can be enabled for one, multiple or all viewports in the current layout: you can switch
between live and instant playback viewports without any limitations. This archive presentation mode is also used
when investigating data from external services and from data sources in the corresponding Ganz CORTROL Client
tabs.

Instant playback mode
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The following overlay controls are available in the instant playback mode:
Upper left:
X - close the stream and free viewport
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up and may therefore be replaced by other camera at any moment
camera name
Centre: play/pause
click to play
drag to the centre of the line to pause
drag right to go fast forward
drag left to rewind fast
release from dragging to continue normal playback
Bottom right: controls
Play button: switch to regular multichannel playback (current layout will be used)
go to a specific time (keyboard shortcut: Space)
create a bookmark with current timestamp
take a snapshot
export loaded footage as a video clip (current timeline boundaries will be used)
Bottom: timeline
use your mouse wheel to zoom the timeline in and out (mouse position will be used as centre)
use the <> arrows to adjust the loaded archive time boundaries (which, by default, are the last
five minutes)
drag right to go forward in time
drag left to go backwards in time
the vertical yellow line indicates current playback moment, drag it anywhere or click to
move along the timeline
the narrow white horizontal line shows recorded video
the cyan line (a little bit wider than the white one) indicates motion
the blue line (a little bit wider than the cyan one) shows recorded incoming audio
the wide transparent white line denotes VCA metadata
bookmarks look like little red flags on the timeline
Instant playback mode has two configurable settings: default duration and rewind time:
default timeline duration is the interval size for the footage presented in the instant playback mode,
default: five minutes (300 seconds)
rewind is the amount of time for the playback to jump back before "now" (the moment when the instant
playback mode was enabled), default: five seconds
Both values can be changed via Ganz CORTROL Client Application Settings.
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Layouts

Layout is a pre-configured viewport configuration with channels assigned for live view and archive playback.
Layouts are created by filling a layout template with video channels. There are two main groups of layouts: local and
shared.
Local layouts are created and stored locally on the same computer where the Ganz CORTROL Client is installed;
these are not available for other machines connected to the same server. However, local layouts can be exported
and then used on other workstations: to do this, simply select Local resources when exporting application settings
via main menu Tools > Export Settings.
Shared, server-side layouts are kept on each server and are available for all users that are connected to the same
server from other client computers. If the license limits the client connection number to 1, layouts can still be shared
between non-concurrent client connections from different machines.
Layout template is a grid-like viewport pattern without any channels bound to it. There is a set of default layout
templates stored locally with each Ganz CORTROL Client installation; also, user-defined custom templates can be
created via Ganz CORTROL Console. Layout template with the channels assigned to viewports can be saved as a
layout.

Layouts section
Drag and drop your desired layout template from the Resources menu on the left - either from the default local
templates or from pre-configured layout templates available under connected server. Template will be empty; drag
and drop channels from the relevant section of the menu on the left onto the layout viewports to fill the grid with
cameras. Channels' contents will be loaded automatically if it is available.
Click the layout menu
button in the upper-right-hand corner - just above the layout - and select Save Layout
to save channel configuration as a new local or shared layout, or to overwrite any of the existing ones.
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Save layout: regular or shared
There are the following additional options:
Choose Save Presets if you wish to save the last activated preset for a PTZ capable camera together with
the layout. If you do, the preset that was used for the PTZ camera will be remembered and loaded together
with the layout, overriding any PTZ position changes, which have been made by any other user/action.
To make the newly created layout available to any user connected to the same server, enable the Shared
option in the layout properties and choose your desired settings: target server and layout group. Users who
have the View permission for the target layout group will be able to see and use your layout; users with the
Administer permission will be able to overwrite your layout using the same name.
Click the Expand

button next to the local layout name in the Resources list to remove the layout.

You need at least one layout group to exist on the target server for you to be able to create shared layouts.
Also, your currently logged user must have permissions to administer the target layout group.
In order to add layout groups, log into the target server via Ganz CORTROL Console under an administrative
account and go to Layouts section; details are available in your server administration user guide. Note that
there are no built-in layout groups.
Together with the layout, the following parameters are saved and loaded for each viewport, both for local and
shared layouts:
channel/map position within the layout template
digital PTZ position
aspect ratio
notification panel
PTZ preset (if enabled when saving PTZ)
The layout menu also allows you to send the currently displayed layout to any of the pre-configured video wall
components. Click the layout menu
button in the upper-right-hand corner and select Display on and then
choose desired video wall and target display number.
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Click the Expand

button next to any layout in the list to bring up the layout menu. From here, you can:

delete the target layout, or
send the target layout to the video wall screen.
Note that created layouts cannot be edited: if you wish to change the layout contents, load current layout contents by
dragging and dropping it on the live view, make desired alterations and then overwrite existing layout by saving the
current layout under the same name.
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Layout Sequences

Multiple layouts can be organized and saved as dynamic sequences, i.e. 'layout slideshows'. Each sequence consists
of two or more successive layouts, either local or shared. Each layout can be set to stay on the screen for a certain
amount of time.
Saved sequences can be exported into a file via main application menu Tools -> Export Settings and then loaded on
other workstations via Tools > Import Settings by selecting the Local Resources option.
To create a sequence, click the

button near Layout sequences in the resource explorer on the left.

Layout Sequences
The Create sequence dialog box will appear.

New layout sequence dialog box
Double-click layouts or drag and drop them to add/remove layouts to/from the sequence. For each layout, the
pause time can be specified separately, with the default layout duration being 15 seconds. You can add each layout
once or multiple times to appear in the sequence. If necessary, use the Search field in the upper-left-hand corner to
find a layout by name. It is possible to use both local and shared layouts.
Enter a name for the new sequence and then click Save. The sequence will appear in the resource explorer under
Layout sequences; drag and drop it onto the view area of any window or double-click the name to activate it for the
main application window. The sequence will then start automatically; sequence controls will appear above the
viewports, allowing you to switch between layouts manually and play/pause; also, the panel will also show the
©2019. CBC AMERICAS, Corp.. All Rights Reserved.

50

Ganz CORTROL Client User Guide
remaining time for the layout that is currently displayed. If there is no connection to the server and shared layouts
cannot be loaded, the message on the panel will say "Retrieving layouts"; as soon as the connection is established,
the target layout(s) will be displayed.

Sequence controls in Live view
Click the |< and >| arrows to switch to the previous/next layout immediately; use the pause button to terminate
playing.
To edit a sequence, click the
button near the sequence name in the resource explorer and select Edit sequence;
to remove it from Ganz CORTROL Client configuration, select Delete sequence. Note that if you delete or modify the
contents of the sequence currently being played, this will not affect current layout slideshow; in order to start the
updated sequence version, simply start it again.

Startup Sequence
Any sequence can be set to start automatically when the Ganz CORTROL Client application is launched. There are
two available setup options:
for local displays, the startup sequences are defined in the Multidisplay setup
for video wall displays in Ganz CORTROL Global, the local startup option is disabled, and the startup
sequence should be assigned via video wall management
To assign a startup sequence to a local display: while in Live view, click the Multidisplay setup button in the top
right corner, then click Advanced to bring up the settings. Select the target window in the list, then choose your
desired sequence from the drop-down list.

Any existing layout or sequence can be set as startup item
Ganz CORTROL Global servers also have a video wall feature. In the same dialog box, you have a possibility to
assign any display to be a video wall screen. If you do so, the startup layout/sequence setting will be discarded
and disabled; to assign a startup item for the video wall display, switch to the Video Wall tab of the Ganz
CORTROL Client application.
First, select the video wall from the resources panel either by double-clicking it in the Resources panel, or by
dragging it from the list onto the upper frame. The video wall thumbnail will appear: click the display you want to
set the startup item for and its current contents will appear below.
Drag and drop your desired layout sequence onto the bottom screen part: the sequence will be placed on the video
wall screen immediately and you will see a preview. Then, click the menu icon
preview and choose Set current layout sequence as startup.
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Set a startup sequence for the video wall display
Next time the Ganz CORTROL Client application is started on the target video wall display, your selected sequence
will start playing automatically. To stop it, select Stop layout sequence from the same menu.

©2019. CBC AMERICAS, Corp.. All Rights Reserved.

52

Ganz CORTROL Client User Guide
17

Motion Overlay

Click on your desired viewport and use the motion icon control in the bottom right corner to switch the motion grid
overlay ON and OFF. This will only work if motion detection is enabled for the selected channel.

Live view with motion overlay on a channel with software motion detector enabled
Apart from motion, other data may be overlaying the video, e.g., textual data and video analytics contents.
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Maps

Maps and geo maps configured via Ganz CORTROL Console can be viewed in Ganz CORTROL Client: simply drag
and drop them from the resources list on the left to any viewport or use drag and drop to load them in the main
application window in live or playback mode. Maps fill the viewports just like channels but, unlike channels, they do
not have any footage or overlay controls. One map can be opened in one viewport or in many simultaneously.
Note that this resource type is not available for the free server license.

Map list in the Ganz CORTROL Client
Maps inside viewports can be digitally zoomed IN and OUT with the mouse wheel and moved around using the left
mouse button (click and drag to move). Double-click inside any viewport with a map to switch to single camera view,
then click again to return to the layout view. Zoom level is preserved when you save the layout with the target map.

Map loaded in Ganz CORTROL Client viewport
All the cameras shown on a map can be loaded in Ganz CORTROL Client with a simple double-click. In order to
pop up a channel from the map:
hover your mouse over the desired device on the map until it becomes highlighted with a pink circle
double-click the target device in order to map it automatically on the first non-locked viewport within the
current layout
change the viewport, drag and drop your desired channel by its title onto to viewport of your choice
if the device stream is already present on the layout, it will blink with a greenish yellow frame
User button markers placed on a map can be double-clicked to trigger the associated action. The marker will blink
indicating that the action is being executed.
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User Buttons

User buttons, as well as other types of resources from the connected servers, are available in the Resources panel on
the left. Note that this resource is not available for the free server license.

User buttons in Ganz CORTROL Client
User buttons are created via Ganz CORTROL Console; button behaviour is defined via Ganz CORTROL Console
using the Event & Action Configurator. There are three ways of using user buttons in Ganz CORTROL Client:
double-click any button in the list of resources to make it trigger the action assigned to it
drag and drop any user button to a live view viewport to make the user button appear as an overlay control
for your desired camera, then click it once at any time to trigger the relevant action
double-click user button markers on the maps (markers are configured via Ganz CORTROL Console)
User buttons cannot be added to the viewports that contain maps. Instead, go to the map management section in
Ganz CORTROL Console and add user button markers to the desired maps to use them in Ganz CORTROL Client.
Starting from the software version 1.4.0, multiple user buttons per viewport are allowed.
Starting from the software version 1.5.0, user buttons can be associated with one or more channels so that they
appear automatically in the viewport when live view of the related channel is shown. This can be set up via
Ganz CORTROL Console, in the User Buttons section.
Each time a user button is pressed, the corresponding log entry appears in the Alerts section of Ganz CORTROL
Client.

Alerts on user button pressing
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Video Wall

Video wall configuration in Ganz CORTROL is very flexible and it allows you to set up video output in virtually any
physical display combination. Templates for video walls are set up via Ganz CORTROL Console and then they
become available in Ganz CORTROL Client, depending on the permissions of the connected user. Using the
dedicated Video Wall tab, you can easily control the contents of all available video walls.
Note that this functionality is only supported for the Ganz CORTROL Global software edition, so connection to a
Ganz CORTROL Global server is required for the video wall functionality to become available.

Video Wall Setup
The idea of the video walls in Ganz CORTROL is that you create a layout in Ganz CORTROL Console and then assign
Ganz CORTROL Client application windows to video wall screens in the layout. Afterwards, the whole video wall can
be easily managed from any location.
In this section, we will review the settings for the Ganz CORTROL Client application windows and see, which ones
are required for the video wall setup.

Advanced Window Settings
To access window setup in Ganz CORTROL Client, open the Live section, click the Multidisplay setup
button in
the upper-right-hand corner - just under the main menu - and then click the Advanced button to bring up the
configuration dialog box.

Advanced window settings
The advanced window settings dialog box offers the following possibilities:
create windows for the available local displays and manage their properties
assign default layouts and sequences to windows (local displays only)
bind windows to video wall displays
In the upper part of the configuration dialog box you will see the available window list. Already there by default is
the main Ganz CORTROL Client window (marked as Primary), which cannot be deleted or renamed. More windows
can be added, their number being limited to the number of displays physically connected to the workstation. For
each window, the following items are displayed in the summary list:
display number
primary or not
startup layout, if set
channel/map pop-ups allowed or not
layout pop-ups allowed or not
start fullscreen or not
video wall screen number, if set
To add a new window, click the + Add window button in the upper-left-hand corner (when the window amount has
reached connected display amount, the buttons becomes greyed out). You can also create additional local windows
by clicking the display thumbnails in the Multidisplay setup menu (before opening Advanced settings).
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Window settings
Select the parameters of the new window and click Save for the changes to take effect.
All these parameters can be set for each window (including default primary window) in the dialog box section below
the window list. The following settings are available:
General settings:
Window name: set window title to be displayed in the application title bar of each window
Startup display: select a display to start the target window on (click to highlight with a yellow frame)
Startup layout or sequence: pick an item to be displayed on window startup; select (Default) to auto
fill a 2x2 layout at Ganz CORTROL Client startup
Start full screen: enable the target window to start in full screen mode; if this is disabled, the window
will start up simply maximized
Allow channel and map pop-ups*: enable video/map popup on the target window as a result of
event/action rule execution
Allow layout pop-ups*: enable layout pop-ups on the target window as a result of event/action rule
execution
Video wall section:
Video wall screen: select to make the target window a part of the video wall configuration; choose the
video wall from the drop-down list below
Video wall visual element: choose (click to highlight with a yellow frame) a video wall screen to serve as
the target window output
Tiled display: enable to split the target video wall screen into several physical displays
Tiles: select the grid size and click a tile to assign the current window to it
*Pop-up options can be selected one at a time: enabling object pop-ups disables layout pop-ups and vice versa.
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Video wall screen assignment
In order to delete a window, select it in the list and click the recycle bin
icon in the upper-right-hand corner; you
will be prompted to confirm the action. Note that all the window settings will also be removed; once you have
removed a window and clicked Save in the Advanced settings dialog box, the deleted window will also be closed.
You can remove any window, apart from the primary one.

Confirm deletion
Assign Video Wall Screens
Briefly: for each application window, enable the Video wall screen setting in the lower section > select the video
wall from the drop-down list > click the desired video wall screen > save. Window settings are explained in more
details above.
For the video wall to be available here, the video wall template should be pre-defined via Ganz CORTROL Console,
and the current user account must have the Manage video wall permission granted. If you have enabled the video
wall setting but there are none in the drop-down list, make sure you have your Ganz CORTROL Global server
connected and check its configuration in Ganz CORTROL Console.
If you wish to combine several physical displays into one virtual video wall screen (tiling), enable the Tiled display
option on the right, then choose which screen side each display belongs to. Tiled walls are explained fully below.

Tiled Displays
Sometimes, flat panel displays with no bezel are combined physically into one ultra high-resolution surface. Ganz
CORTROL Client supports such configurations and allows splitting each video wall display into several tiles, and
further assigning of individual tiles to different physical displays. These displays can be driven either by the same or
different workstations: the resulting tiled wall will look the same. Thus, a set (group) of physical monitors (tiles)
form a single video wall screen, which is then used as the contents' destination. The tiles are set up once, and this
configuration layer is then completely transparent for the video wall management: you will simply address video
wall screens later on, no matter if each screen consists of one or more windows.
To enable tiling, first assign all displays to the same video wall screen, then choose different regions (tiles) for each
physical display using the visual elements.

Tiling example with channel output visualisation
Example: stretch one channel output to two Ganz CORTROL Client application windows, which run on two
different client machines.
Configuration:
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for both windows:
enable video wall in the advanced window settings, as shown above
choose the same video wall and the same video wall screen (e.g., video wall Matrix, screen 1)
enable the Tiled display option
enter 1x2 layout
for Window 1:
choose tile 1 (left)
for Window 2:
choose tile 2 (right)
As a result, Ganz CORTROL Client will automatically treat two displays as a single screen, and any contents sent to
this video wall screen will be stretched to fill both physical surfaces.
Note that the contents of the tiled displays can be defined via video walls only, either by sending items to the
video wall screens from the item menu (...), or by opening the video wall management tab. If you send items to local
screens (by double-clicking or dragging and dropping them from the resources' list), only a part of the tile will be
used, producing an undesirable effect.
Make sure to calibrate your tiled displays so that they have similar brightness and colour settings. These
settings are usually available via operating system or utilities bundled with the graphics card drivers.
Many different displays can be subscribed to one and the same video wall screen.
Example:
in the office, video wall Screen 1 consists of one physical display, and in the control room the same
output is sent to four displays using tiling
when someone manages the video wall from the corresponding tab, the Screen 1 contents is changed
simultaneously in both places
Both channels and maps can be tiled. However, visual overlay elements (e.g., buttons, portals) will be
unavailable. Text from data sources will overlay the video, as usual.

Video Wall Management
Once the Ganz CORTROL Client application windows have been attached to the video wall displays, it becomes
possible to send resources directly to any video wall display. You can do this in two ways: send resources directly
from their menu, or enter the full-featured video wall management mode. The first option is convenient for quick
edits, while the second one allows full control over the video wall contents. Both modes handle video wall screens
and not individual tiles, if the tiled displays are enabled. Thus, you do not need to worry about the tiles: Ganz
CORTROL Client will take care about them automatically.
Below, you will find guidelines on how to administer video wall contents in Ganz CORTROL Client.

Quick Content Output
To send any resource directly to a video wall screen, click the Expand
button near resource name in the list on
the left and choose Display on -> Video Wall -> pick video wall -> pick display number/name. Available resources
are: layouts, layout sequences, maps and individual channels.
To send the currently displayed screen contents to the video wall display, do the same thing from the layout
menu in the upper-right-hand corner (above live view).

Advanced Management
Switch to the Video Wall tab on the upper panel to access advanced video all management. In this mode, your Ganz
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CORTROL Client acts as a controlling client for all the video wall members.
Here, in the left-hand panel, all available resources - both local and server-side - are listed. These are:
video walls: fetched from Ganz CORTROL Global servers, each video wall can be expanded to view its
displays
layouts, layout templates and layout sequences: both local and shared via Ganz CORTROL Global
servers; new sequences can be created from here by clicking the Expand
button
channels: individual channels from all connected servers
maps: fetched from connected Ganz CORTROL Global servers

Video wall management
First, drag and drop your desired video wall from the resource list to the upper section of the window. You can
drag and drop either the video wall name itself or any of its displays. Video wall display arrangement will appear in
the upper part of the window with its corresponding display numbers and names.
Click any cell to view the current contents of the target display: it will be shown below the video wall arrangement.
The title bar of the lower window part will reflect the video wall display number and name, currently displayed
resource type (layout or layout sequence); in the right-hand side of the panel you will have the layout menu, which
will allow you to quickly set the currently shown layout as startup layout for the target video wall display. If the
current video wall display has a layout sequence on it, this menu will offer options to set the current layout
sequence as startup and also to stop the sequence.

In the lower part of the window, you can manipulate the contents of the target video wall display in the exact same
way as you would do in the usual live view mode. You can:
drag and drop layout templates, layouts and layout sequences from the Layouts section of the Resources
panel on the left
create new layout sequences from the Layouts section
drag and drop individual channels from the Channels section
drag and drop maps from the Maps section
close channels and maps in the layout by using the X button in the upper-left-hand corner of the viewport
swap channels and maps within the layout by dragging them by their titles
lock channels and maps in their viewports by using the lock overlay control in the upper-left-hand corner
digitally zoom channels by using the digital zoom overlay control
digitally zoom maps by using your mouse wheel
Indication conventions:
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currently selected video wall screen is marked blue green
the information icon
next to the layout/channel title shows the name of the user who has placed the
corresponding layout/channel: hover your mouse cursor to see the user name
the information icon is highlighted yellow for five seconds after the corresponding resource has been
placed
All changes to the video wall display contents are immediately applied and all other users who are managing the
same display at this moment are notified by the highlighted information icon. If selected arrangements are not saved
as startup layouts, they will be kept until remote Ganz CORTROL Client applications are restarted.
When your Ganz CORTROL Client is connected to the mirroring server instead of Ganz CORTROL Global
(server color indicator changes from green to yellowish), all the changes you make to the video wall
configuration are kept on the mirror server. When the Ganz CORTROL Global machine comes back, all
changes are synchronised back to the primary central management server. All this happens automatically and
transparently for the Ganz CORTROL Client users.
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Playback (Archive) Mode

Select Playback tab to switch to archive playback mode. Your current layout will be used and recorded video streams
will be displayed for channels with enabled recording. If you wish to load footage from a different channel or
channels, or use a different layout or layout template, use the Resources panel on the left:
Layouts: double-click your desired layout to load it
Layout templates: double-click your desired layout template to load it, then double-click or drag and
drop the channels of your choice to fill the viewports
Channels:
double-click a channel to load it automatically within the current layout (first, empty viewports
are filled, then non-locked channels are replaced one by one)
drag and drop a channel onto any viewport to load it there
All channels will be listed under the servers from which they originate; or, if you have chosen to merge resources in
the connection properties, they will form an alphabetically sorted list. Each channel can be clicked and expanded in
order to access recordings of its main an/or secondary stream, as well as separate tracks recorded on failover
servers. When you double-click or drag and drop a channel by its title, all the tracks from its main stream will be
displayed automatically (e.g., tracks originating from different recording servers will be combined to form the
timeline).
All the footage having no associated active channels will be available under Orphan archive tracks. Such
recordings include footage from removed channels, renamed channels and also ZNSNVR archive.
Ganz CORTROL archive is protected with watermark. If archive contents has been modified with third-party
tools, a warning will be displayed during playback and a critical level entry will appear in the Alerts section.

Timeline and Playback Controls
Use the timeline and controls below to browse through recordings. For a multichannel layout, all channels will be
played synchronously.

Archive Playback mode
The following viewport overlay controls are available in the playback mode:
Upper left:
X - close the stream and free the viewport
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viewport lock status: unlocked (default) or locked; unlocked means that the video in this
viewport can be replaced by other camera if you double-click or drag it from the Resources
camera name
Bottom left: stream details
motion detector status: running = motion present, standing still = no motion detected
video codec of the stream
picture resolution, abbreviated
stream frame rate, FPS (only displayed up to 4x playback speed)
Bottom right: controls
audio ON/OFF: disables or enables audio playback
DPTZ controls ON/OFF
aspect ratio (auto/stretch to fill viewport/original)
motion grid ON/OFF

Playback timeline
Right below the video stream, timeline is displayed:
the yellow vertical line denotes current playback position
time intervals show the timeline scale; click and drag left/right to move the timeline
use your mouse wheel to zoom the timeline in and out (current playback position will be used as centre)
the narrow white horizontal line shows recorded video
the cyan line (a little bit wider than the white one) indicates motion
the blue line (a little bit wider than the cyan one) shows recorded incoming audio
the wide semi-transparent white line denotes VCA metadata
bookmarks look like little red flags on the timeline
The video footage outline is shown twice: the upper timeline displays the contents of the currently selected stream,
with the corresponding channel name shown on the left; the lower timeline shows a content summary for all the
channels currently present in the viewport layout, both timelines being synchronised. The second timeline with
summary can be optionally disabled via Application Settings.

Playback controls
The playback mode controls are located at the bottom of the window:
far right and far left of the timeline:
timeline start and stop timestamps
use the <> arrows and drag left to zoom out/drag right to zoom in the timeline
yellow arrow indicates the location of the nearest footage if it is not present on the timeline at
the time (this can happen, e.g., after zooming the timeline)
playback controls:
use the Play/Pause button to start playback
use the <> arrows near the Play button to go one frame back/forward
-/+ steps: click to go back/forward with a step of 10 seconds, 1 minute, 10 minutes, 1 hour or 1
day
|< >| arrows: go to the very beginning/very end of the footage
playback speed:
during playback, drag the blob to adjust playback speed from +/-0.5x to +/-128x (you can use
mouse wheel for this, too)
the Pause button duplicates the main pause control
when paused, set playback speed to start playing video (without pressing the Play button)
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additional controls on the left and on the right of playback controls:
go to the next/previous motion event
I and II markers can be used for selection
clock button: go to a specific date and/or time
bookmark: add bookmark
camera button: take a snapshot of the currently selected channel
camera with a layout: take a multichannel snapshot
video button: export a piece of video
Timeline selection can be created as follows:
1. Click the timeline once to put the playback marker onto the desired starting position
2. Click the selection marker icon
below the timeline to mark the beginning: the corresponding mark
will appear on the timeline
3. Place the playback marker to the end of the desired interval
4. Click the selection marker again to create the selection
5. Click the selection marker again to discard the selection
Once the target interval has been highlighted on the timeline, you can browse the timeline as usual; the selection will
only be discarded if you click the selection marker icon once again or switch to other tabs (live etc.).
The created selection can be used for archive related actions where it is necessary to choose an interval (e.g., export
video clip, delete or protect a part of the archive).

Calendar
Click the Archive Calendar button in the top right corner to toggle an additional panel containing archive calendar
view. This control allows you to see for which dates and time intervals the footage is available, and to switch to some
particular period quickly.

Playback mode with calendar enabled
Units of time (months, days and hour intervals) marked with a blue underline contain footage for at least one
channel currently displayed.

Bookmarks and VCA Event Search

©2019. CBC AMERICAS, Corp.. All Rights Reserved.

64

Ganz CORTROL Client User Guide
The Bookmarks button in the top right corner opens up an additional panel that allows you to browse the existing
bookmarks. You will find more information on this in the Bookmarks section of this document.
Similarly, the VCA button next to the Bookmarks button in the top right corner provides video analytics event
search functionality (recorded VCA events from server): please refer to the VCA Events section of this manual for
further details.

Archive Protection and Deletion
It is possible to mark a certain part of the archive and use the selection for further deletion, or protect a part of the
archive from being removed. Special user permissions are required to allow this functionality.
If you choose to protect a specific part of the archive, it will be impossible to erase it from the Ganz CORTROL
Client application, and that part of the archive will also be ignored by server when applying quotas. To disable
protection, you need to log into the server via Ganz CORTROL Console and change the archive protection settings.
If you choose to remove a part of the archive, it will be erased permanently with all related auxiliary information
(audio, motion metadata etc.). Protected intervals cannot be removed; when such an action is attempted, you will
get a warning in the Alerts section.
When you delete a part of the archive, it is erased immediately. This action cannot be undone. Please
mind applying all the necessary security precautions (e.g., take care of a good administrative account password
and review user permissions) to avoid undesired data loss.
When you protect a short period of the archive (e.g., several minutes), in fact, the whole file containing
this period is protected from erasing. Therefore, intervals adjacent to protected period will also be locked. You
can verify the exact protected interval by opening Ganz CORTROL Console >> Monitoring section >> Archive
statistics >> Protected intervals.
General steps for both these actions are:
1. Mark the beginning and the end of the target interval on the timeline using the markers
timeline
2. Use the buttons in the bottom right corner to either remove
from deletion

below the

a part of the archive or protect

it

You can skip the first step and press the delete/protect buttons without any selection on the timeline; then, the last
five minutes of the recordings will be used as the target interval.

Selection on the timeline
All footage that has been protected from erasing can be un-protected via Ganz CORTROL Console, by logging with
an administrative user account with corresponding privileges. Until then, the protected part of the archive cannot be
erased by user actions (as described above) or by automatic erasing based on quotas.
Protected archive is excluded from recording quotas and will not be overwritten. Also, such footage is
protected from manual deletion. Therefore, when protecting a large part of the footage, make sure that the
target storage has sufficient free space, and set lower storage quotas, if necessary.
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Sequence

The sequence explorer is an archive playback extension with additional tools for footage analysis. The whole
recorded stream can be split into smaller pieces down to 2 minutes in length; each of these can be played separately
or exported with a single click.
In the Ganz CORTROL Client upper panel, click the Sequence tab: the current main window will then display the
sequence explorer with empty viewports.

Sequence explorer interface

Interface Overview
Interface elements have the following designations:
Calendar: specify the time period to be analysed by entering date/time boundaries, and also set the
viewport layout
date can be entered manually or selected from calendar view
time can be entered manually or adjusted by mouse wheel (select the value to be changed and
use mouse wheel to increase/decrease it, while keeping the mouse cursor over the field)
minimum time period is 120 seconds
available viewport layouts are: 3x4 (default), 3x5, 4x3, 4x6, 6x4, 5x5 screens
Top panel: <> arrows enable users to browse viewing history within the channel in use; the name of the
channel being used is displayed
Main window: displays video clip sequence with corresponding controls; empty viewports mean that no
footage is available for the time period selected
Bottom panel: contains global sequence controls for the whole currently displayed period (and not the
selected sequence elements)
the << and >> arrows on the sides enable users to load the previous/next portion of the footage
sequence, with time period equal to the one set in the Calendar
next to the arrows, the date/time boundaries of the current video portion are shown
Play button in the centre of the panel will open current video portion in the Playback mode
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Video button in the centre of the panel brings up the Video export dialog box

Make Sequence
Drag and drop the desired channel from resources onto the main window; the camera name will appear at the top.
Note that the sequencing works with one channel at a time, so if you drag and drop another channel onto the
explorer window, all previous changes will be discarded.
Select sequence timing in the calendar panel on the right and then click the Make sequence button. Video footage
from selected time range will be divided between all viewports, so that all of them will contain video clips of equal
duration. For instance, if the selected time range is 2 hours and a 3x4 layout is set, each viewport will contain a 10minute video clip: (2*60)/3*4 = 120/12 = 10 minutes.

Built sequence
From this point onwards, you have several options for creating a new sequence:
enter a new time period on the Calendar panel and click the Make sequence button
select one or multiple sequence elements and click the Make sequence overlay control (see the control
descriptions below)
double-click a single sequence element to split it into a new sequence
If you choose to build a new sequence out of one or multiple sequence elements, their date/time boundaries will be
set as new boundaries, and the video clip in the resulting sequence will be of shorter duration. In this way, any
footage can be split into smaller and smaller chunks down to two minutes, facilitating footage analysis process and
making it easy to find the scene of interest within a larger fragment of footage.
Use the << and >> arrows on the bottom panel to go back and forth along channel timeline. The size of the jumps
back and forth will be equal to the base time period set in the Calendar.

Sequence Controls
Viewport overlay controls are available for each sequence element. Click any piece once to select it; click one screen
once and then click another screen to select a series of fragments. Selection border style will help you control your
actions: a dashed line denotes a single click, solid line appears after the second click. As a result, you will always
know, which selection stage you are on when selecting multiple screens.
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Select one sequence fragment with a single mouse click
Once you have selected one or a set of fragments, overlay controls in the bottom right corner of the selection offer
the following possible actions:
Magnifier button: make a new sequence out of selected fragments; use the History controls <> in the
upper panel to go back
Play button: play selected footage in archive playback mode
Video button: export video from selected time range (no additional Set time range window is displayed)

Multiple regions are selected with two clicks
Timestamps in the top-left and in the top-right-hand corners of each viewport represent time range of the contained
footage fragment. In case multiple screens are selected, the intermediate timestamps are skipped and time frames
for the multi-fragment footage portion are displayed.

Playback
Click the Play button on the bottom panel to open the whole inspected footage portion in the archive playback
mode. The equivalent button on each of the selected sequence fragments will open just that specific fragment for
playback. Playback operation is exactly the same as for usual archive viewing and it is explained at length in
the Archive Playback topic.

Video Export
Click the Video button in the bottom panel to bring up the Video Export dialog box and set your desired time range
for exported footage; channel selection is limited to the one channel open at the time in the sequence explorer.
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Adjust the date/time boundaries during which you want the footage to be exported
The Video button overlay control in the fragmented sequence screens will automatically export video from selected
time range without additional prompts. In either case, the exported video will appear in the Library.

Library notification
Sequence explorer works with the streams based on the time intervals. If you want a more intelligent archive
analysis tool, go to Smart Search to base your search on motion in certain regions.

©2019. CBC AMERICAS, Corp.. All Rights Reserved.

69

Ganz CORTROL Client User Guide
23

Smart Search

Along with regular archive playback and sequence exploring, Ganz CORTROL Client application provides the smart
search feature, which allows you to specify a region of interest and let software search for motion events in the
defined area based on the existing motion detection (MD) metadata. This advanced search option is available for all
Ganz CORTROL servers and editions.
There are two types of motion analysis operation: grid and area (frame). Grid type detection is
implemented for software-side motion analysis (both High Performance and High Accuracy modes), while
most devices send their motion detection metadata in the form of areas (frames), this is, the software only
knows if the motion was present in the configured zone, and exact location of the motion in that frame is not
available.
Understandably, precise results of smart search can be only obtained for grid-like detectors. Searching
through an area-type stream by motion region will give you motion events whenever motion has been detected
in the configured detection areas. In order to get better search results with device-side detectors, please adjust
the motion detection zone via device Web interface.
In order to start using smart search, click the corresponding tab on the upper panel of the main Ganz CORTROL
Client window.

Smart Search option
When you open Smart Search for the first time since Ganz CORTROL Client application startup, the main viewing
area will be empty. The resources menu on the left will contain all recorded streams, just like in regular playback:
simply drag and drop your desired video stream onto the viewing area in order to start working with it. The panel on
top of the viewing area will have your selected channel and stream name displayed then. The loaded stream will still
be there if you switch to some other tab and then go back to Smart Search.

Smart search with a loaded stream
Search Parameters
The search procedure consists of three main steps: define the region of interest, set the time period and
sensitivity, and analyse the results.
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Once you have selected the stream for analysis, the stream preview will appear in the upper right corner as a static
picture. You can use the buttons below the picture to choose the point in time for the preview: this comes handy in
case the stream comes from a PTZ capable device, or if the underlying device has been moved/replaced. Choosing a
correct scene is crucial for obtaining the correct search results.
Click and drag on the picture to draw a rectangular region of interest. You can mark multiple regions and also
combine them to make them overlap, creating a more complex shape. Press the Clear region button to discard all
areas and start drawing again. If no region is specified, all available motion information will be searched.

Define region of interest
Afterwards, set the search interval using the controls below the picture. You can enter the date manually or use
the calendars to choose a specific day. To manipulate time, click the desired time units and then either enter the
numbers from your keyboard, or use your mouse wheel, while still hovering the mouse cursor over the timestamp.
Next, set the desired threshold for the motion absence by dragging the slider. Threshold range is 5..60 seconds and
it defines how much time should be there between two subsequent motion events for them to be reported as a single
event. For example, if you set the threshold to 5s (minimum), all consecutive motion events with gaps between them
smaller than 5s will be reported as a single search result, and events having more than 5s between them will be
presented as separate results.
When ready, press the Search button to filter the motion events according to your settings. Smart search results
will appear in the central viewing area; if the specified time interval is large, the results may appear not at once but
rather one by one, as the search progresses.
Investigation
Each of the search results will be presented as a preview picture with a timestamp below, the timestamp designating
the beginning of the sought-for motion event. At the same time, all results will be listed on the right-hand side, with
the currently displayed results being highlighted. The list also shows the motion event duration for each of the
results. In the very bottom of the list, the total number of results will be displayed.
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Smart Search in action for a PTZ camera with area type MD
You can change the presentation grid by choosing the desired layout in the drop-down list below the central area:
available layouts range from 3x3 to 6x6 viewports. If there are more results than a single layout can contain, left and
right - |< and >| - arrows will become highlighted, allowing you to browse back and forward. Notice how the
highlighted item set changes as you browse. You can scroll the list and choose any result from the non-highlighted
items; the corresponding portion of results will be then loaded in the viewing area.
Click the event of interest - either a row in the right-hand list or a picture in the central viewing area - to start
working with it: the selected video clip will be looped and played back continuously.

Smart Search result with grid type MD
The overlay control buttons in the bottom-right-hand of each viewport allow you to perform the following actions
(from left to right):
Play button: go the regular Playback mode to view the search result in a single channel mode
Bookmark button: click to add a bookmark at the beginning of the selected video clip
Video export button: selected video clip will be automatically exported
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For just any video clip in the results you can go to the regular playback mode with a single click of the Play button
overlaying the clip; to go back, simply click the Smart Search tab to get back right where you left off.
When you export a video clip from the search results, it is exported automatically with your pre-defined video export
settings, without the need to confirm the time range. You will still be asked for the file name if you have not chosen
to use pre-defined settings. In order to export longer video clips, either go to the regular Playback mode by choosing
the corresponding tab in the top panel, or select a higher Motion absent duration threshold in the smart search
parameters.
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Bookmarks

Ganz CORTROL Client offers an opportunity to mark any specific moment in time so that it can be easily found in
the Playback mode later. It is possible to add bookmarks from live, instant playback, regular playback and smart
search modes; bookmarks are displayed and can be searched through in the regular playback mode.
The bookmark overlay control may be absent in the following cases:
your currently logged user does not have permissions to add bookmarks - in this case, the bookmark
control may be absent for specific channels only
the control had been hidden via application settings (by default, it is enabled)
Also, the bookmark button will be greyed out for orphaned archive tracks in the Playback mode (orphaned
tracks are recordings that have no active channel associated with them).
Add Bookmarks
Select your desired channel by clicking it in live, playback, instant playback or smart search mode.

Among the overlay controls in the bottom-right-hand corner of the channel, locate the bookmark icon
and
click it once. In playback mode, the New bookmark button is situated in the bottom-right-corner of the whole
viewing area, near snapshot and video export controls.
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Bookmark in playback mode can be found in the bottom-right-hand corner
Bookmark dialog box will appear, offering you to fill in the details. Several details are available in the dialog box:
Channel: displays the currently selected channel name, cannot be changed
Time: bookmark time - inserted automatically but can be adjusted (see details below)
Title: bookmark name, e.g., Motion or Person detected (empty by default), which can be later searched by
Description: user comments - a detailed description of what has happened (empty by default)
Bookmark time is automatically inserted using the following logic:
Live mode: the moment of time when you pressed the bookmark button
Instant playback: the currently played moment, the play marker position
Playback: the currently played moment, the play marker position
Smart search: the incident timestamp
and the timestamp in the bookmark details can be changed at this step by using the calendar or manual insertion
(keyboard) for date and click+mouse wheel or keyboard for time.
While you are adding a bookmark, playback (regular or instant) will proceed in the background without being
paused.
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Add new bookmark dialog box
After you have filled in all the desired fields, click Save to add the bookmark at the selected moment in time. Your
newly created bookmark will be available in the bookmark search in Playback mode from now on. Also, all
bookmarks are visible on the timeline: these look as tiny red flags. You can hover your mouse cursor over any of
the bookmarks to get a tooltip with the bookmark timestamp and title. In order to see the description, double-click
any bookmark on the timeline.
Search Bookmarks
All the added bookmarks will be visible in regular playback and also in the instant playback modes, each
bookmark being denoted as a
red flag. Hold your mouse cursor over the bookmark to see its name and exact
time; double-click a bookmark to open a detailed description in a separate dialog box.
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Bookmarks on the timeline in Playback mode
In order to search for and view the existing bookmarks added both by you and other users, go to the playback mode
by switching to the Playback tab on the upper panel of Ganz CORTROL Client. Choose a layout of your preference
either by loading an existing one or by filling the viewports with channels of your choice.
In the upper-right-hand corner, press the Bookmark search button in order to open the bookmark search panel.
Here, you have two options: search by bookmark creation time (i.e., when the bookmark was added, regardless of its
location on the timeline) and/or by actual bookmark timestamp (its position within the timeline). Define the search
parameters in the following manner:
choose whether you want to search by bookmark time, its creation time, or both at the same time
set desired date and time range for bookmark time, its creation time, or both
select a channel from the drop-down list (one of those present in the layout)
if you wish to search for bookmarks for all channels present in the layout, choose the "All visible in layout"
option
optionally, enter a bookmark title or a part of it (without wildcards) to refine your search results
When you have entered all the search conditions, press the Search button to obtain the bookmark list.
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Bookmark search results
Search results will appear in the list in the bottom of the search panel. Single-clicking a bookmark will auto-locate
it on the timeline, allowing you to see the exact moment, to which the target bookmark has been bound: click the
Play button on the archive playback panel to start playback.
You can also double-click any bookmark either in the list or on the timeline to open it and view its contents in a
separate dialog box. Understandably, you will not be able to change any bookmark details.
Found data can be saved into a CSV file (comma-separated values) that can be later parsed or opened with MS
Excel-like applications. To do this, simply click the Export CSV... button below the search result list and specify your
desired file name and path.
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VCA Events

Events from the server-side video contents analysis (VCA) engine, which are set to be recorded together with the
video stream, can be displayed in Ganz CORTROL Client, investigated and also exported to an external file in the
comma-separated format.
VCA event data is available for server-side analytics and also for camera-side VCA in case metadata is
supported for that particular camera brand. For the exact manufacturer list with VCA metadata support,
please contact CBC AMERICAS, Corp. representative.
In the regular playback and instant playback modes, VCA metadata is displayed as a thick white line over the
footage. This means these events can be searched for in the Playback mode. To access the VCA investigation panel,
go to playback mode in Ganz CORTROL Client and click the VCA button in the top right corner.

VCA event investigation in the playback mode
The appeared panel will allow you to specify the search criteria, which are:
Source: a channel currently present in the layout that has VCA enabled
Search interval: time range to look for the events in
Search for: VCA item to search for, can be an object, a counter or an event
Object: all entries containing object appearance according to the VCA object classification
Counter: all moments where any counter value was changed
Event: all entries from triggered VCA rules
Class name: VCA class name (full or partial) according to the VCA internal object classification
When ready, press Search to get the results based on your refinements. Note that a maximum of 2500 events can be
listed at a time. Click any result in the list to jump to it in playback, then press the play button below the timeline to
start viewing the footage.
Found data can be saved into a CSV file (comma-separated values) that can be later parsed or opened with MS
Excel-like applications. To do this, simply click the Export CSV... button below the search result list and specify your
desired file name and path.
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Reports

This section provides reporting functionality based on the previously collected data. There are two types of reports:
heatmaps, based on motion information, and charts, which use data from the software and VCA counters. You
can view the reports in the application and then export the results.

Heatmaps
Heatmap type reports represent motion density in the picture, thus highlighting the regions where the most
motion has happened during the selected time range. Heatmaps are generated based on the motion detector
(MD) data, therefore, motion detection must be enable beforehand for the target channel via Ganz CORTROL
Console application.
Here are the requirements and some recommendations regarding heatmap reports:
target channel must have grid type MD enabled
motion information must be recorded with the video (represented by cyan colour on the timeline in
playback mode)
for PTZ cameras, make sure to select a static interval (during which the camera was not panned, tilted or
zoomed), otherwise the map will be inaccurate
Heatmaps use data from grid type motion detectors. Grid is guaranteed for software-side MD, and also for
a few device-side detectors. Heatmap detalization depends on the MD grid size: the smaller the grid cell, the
finer the map will be.
Most of the device-side MD do not support grid mode: if this type of MD is enabled in the device properties in
Ganz CORTROL Console, you will get an "unsupported MD configuration" error and the heatmap will not be
generated.
To start, drag and drop a channel from the resources panel on the left. The channel name will appear on top of the
viewing area. If, for some reason, there is no motion data, or it is incompatible (frame type instead of grid), you will
get a corresponding error.
Next, select the target time interval, days and hours to be analysed:
Heatmap interval: defines the total report period
Filters: define the target range of time and exact days to be taken into account
For example, you can select one month as the time interval, and then only select weekdays (Mon-Fri), from 8AM to
8PM.
Use the Set time, +1h and -1h buttons below the channel preview to select the image to be used for the heatmap
overlay. Particularly, this makes sense for PTZ or zoom-only cameras, where the snapshot time matters. Also, you
might want to use this option to find a timestamp where lighting conditions are optimal, or there are no unwanted
objects in the scene. Use the Reset filters button below the settings in the right-hand panel to restore the default
filters (all days 24/7).
When ready, hit the Generate heatmap button: depending on the selected interval, this may take some time, and
you will see the generation progress displayed as percentage.
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Heatmap report example: red=max, blue=min
As soon as the analysis is complete, the heatmap will appear in the viewing area. Colours on the heatmap range from
blue to red, blue representing the "coldest" places (where the minimum amount of motion was detected for the
given period), and red stands for the "hottest" places (the maximum amount of motion). The rest values will be in
between (blue>>violet>>red). Regions without any colour overlay are those without any motion detected for the
specified period (including, but not limited to, non-detection zones).
Click the Export heatmap... button below the image to save the snapshot with the heatmap overlay as a JPEG
file. An additional dialog box will pop up, allowing you to choose the destination folder and the file name.

Charts
Ganz CORTROL Client application provides an opportunity to build graphs based on the counter data, which has
been recorded with the video stream(s). Depending on the collected information context, these reports can be used,
for example, to estimate the average number of customers during specific hours, compare the number of passing
cars to the number of trucks etc. Counter information is collected from Ganz CORTROL Open VCA video analytics,
camera-side VCA (for certain manufacturers) and software counters.
For the exact list of supported camera-side VCA counters, kindly contact our support engineers at
cortrol@cbcamerica.com.
There are three chart types: bar, line and pie diagram. Regardless of the chosen type, all reports are based on the
counters and have configurable report interval and days and times of interest. Counter values are compared for the
given period and with the specified scale, and the results are then reflected in the chart of the selected type. Any
report can be also exported as PDF.
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Bar diagram report example
In your Ganz CORTROL Client application, switch to the Reports tab: this functionality will be available when at
least one of the connected servers has Open VCA operating or software counters configured for at least one of its
channels, and the used user account has sufficient privileges to access the recorded counter metadata. If you have
just added a new counter, please wait several minutes for the data to be collected and flushed into the database
before it becomes available.
Automatic report generation is also available for Ganz CORTROL and can be configured via the Ganz
CORTROL Console application.
You do not need to set VCA channels manually: all the available counters are listed automatically in the right-hand
panel, under Counters, with the channel title displayed in brackets next to the counter name.
Specify the reporting criteria in the right-hand panel, which is divided into several sections.
Counters:
Select desired one or more Open VCA counters to be included in the report (none are selected by default)
All the counters present in the system are listed, with their source channels specified in brackets
Report time interval:
Choose the start and end date and time for the target report
Report filters:
Week days: select days of the week that you want to be included in the report (e.g., ignore weekends)
(all days are selected by default, marked blue)
Day time interval: choose the target audit interval to be analysed for each of the selected days
Report visualisation settings:
Select the diagram type by toggling the icons: from left to right, these are bar, line and pie type; the
currently selected mode is marked blue
Aggregation: specify the scale factor for the target diagram - results can be presented for months,
weeks, days, hours or minutes (also, the data can be aggregated by counters if the selected chart type is pie
diagram)
The counter value setting lets you choose, what value is taken for each report time interval on the X axis
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(day etc.):
Absolute: actual counter value
Relative: difference compared to the previous interval
Average: arithmetic mean of the given interval
Minimum: minimal value during the given interval
Maximum: maximal value during the given interval
Choose whether you want each counter to be represented separately or all counters are to be added up
Report interval defines the whole period to be reflected in the report. Report filters specify which
exact time period should be analysed for each of the selected days of the time window specified as the report
time interval.
For example, if you wish to examine customer flow during working hours for the past two months, you need to
set:
two months' period in the Report interval section
only mark working days in the Report filters section (unmark the weekend as all the days are preselected by default)
set the time interval under Time filter in the Report filters section to your target working hours
Choose the diagram type by toggling the icons in the bottom of the right-hand panel in the Report
visualisation section: from left to right, these are bar, line and pie type. The currently selected mode is
marked blue.

When ready, hit the Make report button in the bottom of the right-hand panel to display the report diagram based
on your selected criteria. Note that the chart will be built step-by-step and you will see how the newer data appears
on it: if the requested report interval is large, the total time required for the chart construction may increase to
several minutes. You will see the Loading... status in the right-hand panel indicating that reporting is in progress.
You can modify the report criteria and restart the reporting process without having to wait until the current diagram
is finished.
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Pie diagram report example
On each diagram, the horizontal axis (X) represents time in the specified scale, and the vertical axis (Y) reflects
counter values. The counter values for each time interval are calculated based on the selected setting and can reflect
absolute, relative, average, minimum or maximum counter value for the given interval. In the pie diagram type,
each sector can represent either a time interval or a counter, depending on the aggregation setting parameter.
Each chart also contains a legend that provides information about colours used in the diagram:
if you have selected to analyse every counter separately, each counter will be represented with its own
colour and the legend will reflect counter titles
if you have chosen to sum the counter values:
bar diagram will have just one column for each interval, every column consisting of specified
counters and its total height reflecting the total
line diagram will contain graphs for each individual counter and the total
pie chart will reflect the counter sum for each time interval if aggregation by time intervals is chosen, so
the legend will contain timestamps; if aggregation by counters is selected, the pie will reflect the
proportion of the counter values for the whole selected audit interval
Any report can be also saved in PDF format. To do so, click the Export report button above the diagram and
specify the file name and path for the report to be exported to in the dialog box that appears; then, click the Export
report button in the dialog box to create the file.
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Access Control

If your Ganz CORTROL server employs a connection with a third-party access control system, it is possible to view
events and other data from the integrated module in the Ganz CORTROL Client application.
Here is an example of how this can be done based on the connection to Doors .NET, which is possible thanks to the
integration of Ganz CORTROL with Keri Systems.

Access Control
To start working with the access control data, switch to the Access Control tab in your Ganz CORTROL Client
application.

Access control tab
There are three sections available here:
Events: the list of door events
Doors: door list with statuses
Cardholders: the list of cardholders
Click any event to view its details and associated recorded video (if a channel has been bound to the door in Ganz
CORTROL Console). Events can be filtered based on time, door name, cardholder and/or event name (or a part of
it). Playback will appear on the right side as instant playback, with all usual controls, when an event is selected.
Click any door in the list to view its live status and associated live video (if configured). Every door will also have
three buttons to let you lock, unlock or temporarily unlock it. The View door events button will take you to the
Events section, with the event list filtered and only displaying entries related to the selected door for the last day.
In the Cardholders section, you will have the list of cardholders with pictures, if there are any. Use the Refresh
button in the bottom to reload the list. The View cardholder events button on the right will take you to the Events
section, similarly to door events: the event list will only display events for the target cardholder for the 24 hours.

Maps
Apart from the dedicated Access Control sections in Ganz CORTROL Console and Ganz CORTROL Client
applications, it is also possible to place door markers onto maps – either regular ones or geo maps. Markers on the
map reflect door open state and lock state. If such maps have been configured on the server, they will be available in
the corresponding section on the left, in the Resources panel.
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A map with door markers
In the Ganz CORTROL Client application, place your map into one of the viewports either by dragging and dropping
it or by pressing the … button next to the map title and choosing the destination display.

Right-click a door marker to see door related actions
Each door marker will reflect status according to the settings defined in the map configuration. Also, every door
marker can be left-clicked to bring up a drop-down menu with associated door actions, these being: lock the
door, unlock the door and temporarily unlock the door. When triggered, these actions will be displayed in the Events
list in the Access Control section.
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Video Overlay

Channel Shortcuts
Channel shortcuts are interactive video overlay elements in live view, which allow you to switch to other (predefined) channels. These can be thought of as "portals" to other channels. A simple usage scenario is to place
shortcuts on doors or street turns, so that users can track people as they move between the different camera views.
Shortcuts are configured in Ganz CORTROL Console and then are visible in the Ganz CORTROL Client application
as coloured rectangles overlaying the live video. Single clicking them will instantly display the linked resource
instead of the current channel. The shortcuts only work in live view and are invisible in other modes.

Street view camera with channel shortcuts
If the feature is not used, you can turn OFF the overlay visibility in the Ganz CORTROL Client application settings:
this will disable the shortcut functionality. To do this, go to the Ganz CORTROL Client main menu Edit
>Application settings > Viewport overlays > Video overlays section and select the Always OFF option.

Text Overlay From Data Sources
If the connected server has data sources configured and these are associated with video channels, the received
textual data is displayed in Ganz CORTROL Client application embedded with the video in the live view and in the
instant and regular archive playback, and it is also possible to search through the recorded text.

Live View
Textual data from the associated external data source will appear embedded with the live video stream. This
happens automatically and you do not have to do anything else in Ganz CORTROL Client to enable the video
overlay.
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Live video stream with text overlay
Text layout is configured via Ganz CORTROL Console application for each channel.

Playback
The same functionality is available in the instant playback and regular archive playback modes, if the data stream is
set to be recorded with the target channel's video. There are no separate markers on the timeline so the timeline
looks just the same as for a regular video stream.
Note that the data stream is not displayed in the smart search and sequence explorer modes. To export the text
together with the video clip, use MKV output type with VP8 compression.

Investigation
If at least one of the connected servers has data sources attached to its channels, an additional tab will appear on the
top panel, named Data Sources. The search logic here is as follows:
specify the target channel(s) by clicking the + next to the channel name in the Resources pane on the left;
use the - next to the channel to deselect and exclude it from the search
enter you search criteria and time range in the panel on the right side: the date can be either entered
manually from the keyboard or selected using the calendar control
click the Search button to view the results
Please note that, depending on the selected time range and number of channels, the search may take some time; the
results will be listed in the central viewing area after they have been found. Do not press the Search button
repeatedly: this will re-initiate the search process.
Double-click any specific search result and it will be opened in the central viewing area in the instant playback
mode.
Found data can be saved into a CSV file (comma-separated values) that can be later parsed or opened with MS
Excel-like applications. To do this, simply click the Export CSV... button below the search result list and specify your
desired file name and path.

Video Export
Textual data can be exported with the video clips, embedded as hard subtitles. In order to do this, you need to export
your desired video file in MKV format using VP8 compression, with hard subtitles and external data enabled.
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Video export settings for clips with text overlay
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Alerts

The alerts section of Ganz CORTROL Client features server notifications, e.g., logon/logout, camera events, as well
as miscellaneous errors that arise during operation: stream errors, server connectivity issues, device connection
errors and others. For example, if archive is corrupt or has been altered with third-party tools, a critical warning will
appear here.

Alerts section
Use the Search field in the upper-right-hand corner to filter alert messages.

Alerts section with filtered messages
Along with type and source, alert message and time are shown for each entry. If the message is too long to be
displayed in full, hover the mouse cursor over it to read full message text.

©2019. CBC AMERICAS, Corp.. All Rights Reserved.

90

Ganz CORTROL Client User Guide
30

Video & Snapshot Export

Video clips, frame sequences, multichannel layouts and individual pictures can be exported in order to be viewed
later. without CBC AMERICAS, Corp. software.

Snapshot Export
A snapshot of an individual channel can be taken at any time from live view, sequence explorer, instant playback and
regular playback modes. To save a snapshot, click the Snapshot
controls.

button in the overlay controls or bottom panel

In playback mode, it is possible to export a snapshot that will consist of all channels present in the current layout. To
do this, use the Multichannel Snapshot

button in the right side of the bottom panel.

The frames will be saved with your pre-defined frame export settings, if this option is enabled in the Application
settings; otherwise, you will be prompted to specify the file name and quality preference. After you have clicked the
snapshot or multichannel snapshot button, the frame will be automatically saved in JPG format and will appear in
the Library section of Ganz CORTROL Client.

Video Export
Video export settings can be pre-defined in the Ganz CORTROL Client Application settings. These include: file
name, output format, compression and resolution preferences, as well as subtitle settings. Some of the settings,
when selected, allow additional features like motion blur.
If you wish to embed the external textual data with the video or use motion blur, use MKV export format
with VP8 compression. MKV format also exclusively allows to export video in time lapse mode.
Time presentation settings do not affect video clip export. When you export a video clip from a remote server,
which is in a different time zone, and add timestamps in subtitles, your local time will be used.
You can choose to use the pre-defined settings always; otherwise, you will need to confirm or adjust the export
settings every time you export a video clip from anywhere. All the exported fragments will be displayed in
the Library immediately.
Video can be exported automatically (without additional time range prompt) by clicking the Video Export
button in the viewport overlay controls:
from Sequence Explorer, by selecting a range of at least two video fragments: selected clips will be
exported
from the Instant Playback mode: the most recent currently loaded footage will be exported at once (last 5
minutes, by default).
from the Smart Search mode, by selecting the desired search result: selected fragment will be exported
A video export dialog box with additional settings can be launched in the following ways:
from Playback mode, by clicking the Video Export button in the bottom right panel (the channel choice is
limited to those that are currently displayed plus multichannel export)
from Sequence mode, by clicking the Video Export button in the centre on the bottom panel (channel
choice is limited to channels currently being viewed)

©2019. CBC AMERICAS, Corp.. All Rights Reserved.

91

Ganz CORTROL Client User Guide

Video export dialog box
When exporting from Playback with advanced options, you will have an opportunity to choose the stream to be
exported (from the channels currently present in the layout) or, alternatively, choose to export the clip with all the
displayed streams (multichannel export); also, you can combine any video stream with any audio stream (also
coming from one of the displayed channels).
In Sequence mode, stream selection is reduced to the sequenced one and you can choose whether or not you wish to
export the associated audio stream, too. In both modes, you can specify the date and time range for the exported
video clip.
All exported video data is split automatically into files of ~1.8GB size to guarantee that the files are played
correctly. The file size and time required for export depends on the selected file output format, compression,
resolution and subtitle presence.
Select your desired date and time boundaries for the export of the footage: dates can be picked from the drop-down
calendars, times can be adjusted by clicking hours/minutes/seconds and then scrolling up/down with mouse wheel.
When you are ready, click the Export button; the video file will be saved with your pre-defined video export settings,
if enabled; otherwise, you will be prompted to specify the stream properties and export directory.

Motion Blur
Exporting video clips with MKV+VP8 settings gives you an extra option to apply privacy masking to the video.
The video is retrospectively scanned for motion (software-side MD is applied) and the selected regions are blurred,
thus hiding whatever is behind the motion. First, enable the feature in the video export settings, and then an
additional dialog box will pop up every time you export a video clip.
To enable privacy masking, choose the following settings for video export:
Video output file type: MKV
Video compression: VP8
Motion blur: enabled (checkbox)
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Video export settings for enabling motion blur
Next time you export a video clip, you will be asked if you wish to proceed with motion blur. Click Yes to open the
dialog box and adjust blur settings, or click No to export this video clip without any masking.

On the right side, choose the settings you find appropriate:
Grid size: motion grid dimensions for both region selection and motion processing, can be 16x16, 32x32,
or 64x64 (larger grid size corresponds to smaller grid elements)
Intensity: blur level, ranging from very low (minimum blurring) to very high (heavy blurring)
Motion sensitivity: detector intolerance to changes, ranging from very low (small fluctuations will be
ignored) to very high (smallest changes will trigger MD)
Then, draw detection areas over the preview image. Simply select the area type and mark the desired grid cells
according to the required masking levels:
no blur (transparent, no colour)
blur always, regardless of motion presentce/absence (red area)
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motion blur with specified sensitivity (blue area)
By default, when the blur dialog box is opened, the whole image is marked blue, which stands for motion blur
only. Draw over with a different colour to change the detection type.

Privacy masking using motion blur
When ready, click Apply and export: your video clip will be then exported with the blurring effect. Depending on the
selected blur settings and video clip size, this make take some time: the selected part of the video stream will
be analysed for motion, meaning that the existing motion data, if present, are ignored. This also means that privacy
masking can be applied to any video stream, even if there are no motion data present in the archive.
If you wish to discard blurring but still want the video clip to be exported, select Skip blurring: the video will be then
exported immediately, without privacy masking. Finally, if you have changed your mind and no longer wish to
export the video, click Cancel export to simply close the dialog box.
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Library Section

The library displays all the exported video files and snapshots that are available, as well as ongoing export jobs.
Essentially, the library section merely displays the contents of the directory, which has been set in the application
settings as target folder for the exported files. The file list is refreshed upon Ganz CORTROL Client startup and every
five minutes after that, so if some files are removed manually via Windows Explorer, it will take up to five minutes
to synchronize the changes.
Files that are still being exported (current export jobs) will be shown in grey, with the current export percentage
shown in the Status field. After that, the entries stay in the list with related details and export status.

Library section
Click the Open button on the upper panel or just double-click any file to open it with your OS default media player:
exported video files and images can be opened by standard media players (Windows Media Player, VLC etc.). This
normally works for AVI and JPG file formats; for other video formats (MKV, MP4), you may require the Portable
Player tool.
Use the Show in Windows Explorer button to display the export directory containing the selected file.
To remove files both from the library and from the hard disk, select one of multiple files and click Delete button on
the upper panel. Use the Search field in the upper panel to filter the items.

File Export to External Media
Click any file or files and hit the Copy to... button on the upper panel if you want to copy the target file(s) elsewhere,
i.e., on a USB drive, a CD/DVD etc. File copy dialog box will appear; click Browse and select your desired location.

Choose destination
If you choose a regular disk or a USB drive as a destination, your file(s) will be simply copied into that directory.
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Should you want to burn the file(s) to a CD/DVD, additional Windows dialog box will appear.

Choose USB flash drive type
In this dialog box, select the desired option. Insert a CD/DVD into your CD/DVD-ROM and click Next. Windows will
format the media, if necessary (if unformatted). Note that, whichever option you choose, the burning process will be
handled by Windows, not by own Ganz CORTROL means.
You can either use a blank CD/DVD or append files multiple times to the same CD/DVD if you use the first USB flash drive - method, as if the disk were a USB drive.

Windows is preparing media
Next, you can select Watermark Validator and/or Portable Player to be added to the target location together with the
file(s).
Watermark validator is a tiny tool that will allow you to check file watermark and confirm they are integral and
intact. Note that if you are copying file(s) repeatedly to the same location and watermark Validator already exists
there, it will not be added twice. Portable player is a standalone media player designed to play back media files
created by Ganz CORTROL.
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Review your preferences before copying
When ready, hit Copy to transfer the files to the specified location. If you have chosen to burn a CD/DVD, Windows
will handle the burning process.

Copy progress
Copy progress will be reflected in the library section. When the process is finished, you will be able to:
use the Show in Windows Explorer button un the upper panel to open file destination
open and play the file(s) using Ganz CORTROL portable player
open and play the file(s) using standard Windows or third-party video player on the same or on a different
computer
run Watermark Validator and check file integrity by dragging and dropping them into the validator
window
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Multidisplay Setup

Click the Multidisplay setup
button in the upper-right-hand corner of the live view, next to the Save layout
button, to bring up the display selection menu.
Ganz CORTROL Client automatically detects computer display configuration directly from Windows display
settings: click Identify to show the display numbers on all monitors - this will helpful if there is a large number of
displays. To change your multimonitor configuration, go to the Windows Control Panel -> Display -> Screen
Resolution.

Multiple display selection
Ganz CORTROL Client automatically detects which screen it is currently on: this display is marked blue and it is not
possible to create any child windows on it. Click on any other empty display (marked gray) to open a new live view
window there: the child window will be opened maximised, with the display number shown in the application
header. The controls in the upper-right-hand corner give the option to enter fullscreen or to close the extension
windows.
For the multiple display configuration, the following logic is applied:
the main Ganz CORTROL Client application window acts as a parent window, in the sense that:
child windows for extension screens can be created and closed independently
when the main application window is closed, all other windows are closed as well
the main window can be located on any screen
only one application window can be opened per screen
child windows are maximized to fill all screen
child windows do not have menus or panels, just live view mode
double-click layouts and/or channels to load them in the main application window
drag and drop layouts and/or channels from the main window list to extension monitors
The advanced window settings dialog box offers the following possibilities:
create windows for the available displays and manage their properties
assign default layouts and sequences to windows (local displays only)
bind windows to video wall displays
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Advanced window configuration
In the upper part of the configuration dialog box you can see the available window list. The main Ganz CORTROL
Client window (marked as Primary) is always present in the list and it cannot be deleted or renamed. More windows
can be added, their maximum number being limited to the number of displays physically connected to the
workstation. For each window, the following items are displayed in the summary list:
display number
primary or not (cannot be changed)
startup layout/sequence, if set
channel/map pop-ups allowed or not
layout pop-ups allowed or not
start fullscreen or not
video wall screen number, if set
All these settings can be changed below.
To add a new window, click the + Add window button in the upper-left-hand corner (when the number of
windows has reached the number of physical displays, the button becomes greyed out). Select the parameters of the
new window and click Save for the changes to take effect.
If you make some window a part of the video wall, the startup layout/sequence setting will be reset and
greyed out, as video wall startup settings should be defined in the video wall management tab.
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Keyboards & Joysticks

Ganz CORTROL Client offers a set of keyboard shortcuts for most interface controls and operations, and also gives
you the option to re-program every single key combination, allowing you to assign your own key combinations to
every available operation (action). This is true not only for the standard computer keyboards, but also for PTZ
keyboards and joystick controllers.
The controller device should be DirectShow compatible in order to be recognized in Ganz CORTROL Client.
All keyboards connected to the Ganz CORTROL Client station are automatically detected and listed as available for
shortcut configuration; the list of default shortcut mappings is also attached automatically, if it is available for the
target controller. For PTZ keyboards, joystick functionality is not listed but it is implied that all joysticks have the
same behaviour, which includes pan and tilt on X and Y axes and zoom on Z axis. If you wish to calibrate your
joystick before using it in Ganz CORTROL Client, please go to the Windows Control Panel and find your device
under Devices (Devices and Printers section).
The list of available commands is the same for each connected controller and cover most of the actions that
can be performed in Ganz CORTROL Client. Commands cannot be added to the list manually at user's will but
it is likely that the list of the available programmable actions will be expanded based on the customer
feedback.
In order to view and edit the shortcuts, go to the Ganz CORTROL Client main menu -> Edit -> Command mapping.

List of mapped commands
From the Devices drop-down list, choose the keyboard you wish to configure the shortcuts for; if your device is not
in the list, make sure that it is connected to the server and that its driver has been installed correctly. Some devices,
such as standard keyboards, have an extended pre-configured (default) set of command shortcuts covering almost
all the available actions; generic ones have either no default configuration or shortcuts for calling first ten presets of
a PTZ-capable camera.
In order to change shortcut mapping and replace it with your own key or key combination, simply double-click the
target command and enter your desired key combination from the keyboard. A minimum of one and a maximum of
four keys is expected for the standard keyboard, and a maximum of two keys - for PTZ keyboards or joysticks. If the
entered key or key combination is already used somewhere else, you will be prompted to either confirm the new
mapping or discard the changes and pick another shortcut.
Use the Load Defaults button in the bottom-left-hand corner if you wish to discard all changes for the currently
selected controller and load default configuration instead.
When you have finished with the shortcut configuration, click Save to confirm all changes and close the dialog box.
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External Services

External services in Ganz CORTROL are, primarily, LPR (License Plate Recognition) and FR (Face Recognition)
modules, as well as any system-specific third-party modules that have been integrated with Ganz CORTROL via
HTTP API. If additional external services have been enabled and set up for your server(s), these will allow you to
receive live event streams for the corresponding channels and also to investigate the recorded event data together
with the video streams.

Live
If recognition is running for a specific channel, you can see the recognition results by opening the Notification Pane
for each individual channel. The pane can be toggled using the viewport overlay controls, and its availability can be
set up via Application Settings.

Live view with LPR recognition
The list of the live results is cleared when you close the Ganz CORTROL Client application meaning that each time
Ganz CORTROL Client starts with an empty notification pane and it gets filled as the recognition results arrive.
If your target channel is recorded, you can double-click any entry to see the moment of the recognition played
back automatically in the same viewport using the instant playback. The recording status is showed by the overlay
icon in the bottom-left corner of the viewport (yellow = recording ON, white = OFF).

Investigation
For every external service type, a corresponding tab appears on the topmost panel of Ganz CORTROL Client. Click
your desired tab to proceed with the investigation.

LPR external service tab in the Ganz CORTROL Client application
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In order to start searching for the recognition results, you need to specify the target channels first. To do this,
click the + (plus) next to the channel, service group or server name in the Resources pane on the left; you can add
multiple channels from different external service groups. Use the - (minus) next to the channel, group or server
name to deselect and exclude it from the search.

LPR channel selected in the Resources pane
Next, enter your keywords in the search field. For license plate recognition, you can enter either the whole plate
number or a part of it - with or without an asterisk (*) as a wildcard.
For face recognition, the following search adjustments are available:
upload a photo and draw a region to contain a face to search for
specify search accuracy (higher accuracy is recommended for better results)
enter the person's name or a part of the name if you know it is present in the FR subjects' database
use tags to refine the search: tags are available only when all channels have been selected for search

Investigation of the face recognition results
Specify the target date and time range: the date can be either entered manually from the keyboard or selected using
the calendar control; the time can be also either entered manually or adjusted using your mouse wheel after clicking
the digits and holding your mouse cursor over the time element.
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Investigation of the license plate recognition results
After that, click the Search button to view the results. Please note that, depending on the selected time range and
number of channels, the search may take some time; the results will be listed in the bottom-right-hand area after
they have been found. Do not press the Search button repeatedly: this will re-initiate the search process.
Double-click any specific search result and it will be opened in the central viewing area in the instant playback
mode, the recognition moment (plus some seconds before and after) being looped.
The instant playback here has some standard Ganz CORTROL Client controls and also an option to switch to the
regular playback mode.
Use the semi-transparent Play viewport overlay control in the centre of the picture to play faster, slower or
pause the playback: simply drag the arrow to the left/right/centre position
Timestamp in the upper-right-hand corner of the picture shows server time
The small Play icon in the bottom-right-hand corner will take you to the Playback mode
The Clock overlay control allows you to go to any particular moment in time in the same playback window
The Flag icon will open the Add new bookmark dialog box, allowing you to add a bookmark to this specific
moment
Pressing the Camera icon will export a snapshot
Pressing the Video clip icon will automatically export the piece of video, which is currently being played
The timeline contains the recognition related time interval but you can also adjust the boundaries by
clicking and dragging the arrows on the left and right sides of the timeline (minimal interval is ten
seconds)
You can switch to other tabs while investigating and you can return to the exact place where you left off by switching
back to the External Service tab, provided that you do not close the Ganz CORTROL Client application. If you do, all
your search results will be discarded.
Found data can be saved into a CSV file (comma-separated values) that can be later parsed or opened with MS
Excel-like applications. To do this, simply click the Export CSV... button below the search result list and specify your
desired file name and path.
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Appearance and Operation Modes

Time Presentation
Timestamps displayed for live streams and playback (regular/instant) are using local time by default. You can
change this to UTC or to the time zone of a specific connected server: this is useful when you view contents from
many servers located in the different time zones.
You can access this setting via main menu View -> Time Presentation -> [option].
Time presentation settings do not affect event logging (Alerts tab). Also, when you export a video clip from a
remote server, which is in a different time zone, and add timestamps in subtitles, your local time will be used.

Operation Modes
Ganz CORTROL Client has three special operation modes:
always on top
exclusive (no access to other applications or resources)
locked (all Ganz CORTROL Client controls are unavailable)
You can activate these by selecting the relevant option via main menu View -> [option].
Each next operation mode includes the previous one. Thus, exclusivity mode also makes the application stay on top,
and the lock application mode also makes it exclusive and on top.
In order to use these modes on Windows 8, 8.1, 10 and Windows Server 2012 - the operating systems
having Windows Metro interface design - it is necessary to disable Windows Logon Screen. Without doing it,
exclusivity mode and locked application mode can be overridden by using Windows button.
In order to do so, go to your Start menu and locate the following shortcuts under Ganz CORTROL category:
Disable Windows Logon Screen controls - this one will disable Windows interface elements, allowing
you to use Ganz CORTROL Client operation modes properly
Enable Windows Logon Screen controls - this one will enable Windows welcome screen back
After disabling the Windows Logon Screen controls, launch Ganz CORTROL Client and use application
operation modes as required.
Exclusivity and locked modes require a password to be defined, and this can be set in Application settings. If you
have not already set a new password, you will be prompted to do so upon enabling the exclusivity/locked mode.
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Themes

Ganz CORTROL Client colour scheme can be modified by changing the colours of individual elements and/or
element groups: buttons, date/time pickers, overlay controls etc. This functionality is available through Ganz
CORTROL Client main menu Edit -> Theme.

Theme settings dialog box
All elements whose colour can be changed are grouped logically within the list and shortcuts to the groups are listed
on the left hand side.
Colour palette consists of three sections:
available colours: hues used in default Ganz CORTROL Client looks
standard colours: pure hues with names (e.g., white, gray, purple etc.)
advanced settings: fully customized colour choice from RGBA (red, green, blue and alpha for
transparency) colour picker
All colours are coded in 8-digit hexadecimal RGBA notation; colours from the standard palette can be also referred
to using names, for example, black, white, red etc.
As you change the colours, they are immediately applied to the application theme. Once you have created the
desired colour arrangement, you have the following options:
Save as: save the theme settings into a XAML file
Save: save latest theme modifications and exit
Cancel: discard the latest changes and exit
Load defaults: discard all changes and reset the colours to CBC AMERICAS, Corp. provided
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Administration Tool

It is possible to customise Ganz CORTROL Client looks by restricting certain functionality if users are not supposed
to see specific tabs, panels and/or menu items. This can be achieved by using the Ganz CORTROL Client
administration tool, which is available via Windows Start Menu, under Ganz CORTROL, or via Ganz CORTROL
Client application's main menu View -> Administration Tool.
Windows Administrator rights may be required to launch this utility (UAC in action).
Every listed item is enabled by default; it is possible to hide it from the Ganz CORTROL Client user(s). Note that
these settings are only applied to the Ganz CORTROL Client application instance running on the local machine and
are not related to the user accounts used for server connection. In other words, for example, if you restrict access to
the Live tab, it will be hidden for both regular users and also the root administrative account(s).

Ganz CORTROL Client administration tool
Currently, the tool offers the following functionality restrictions:
Visibility settings
Panes
Layouts: layouts, layout templates and layout sequences in the resources pane on the
left hand side, both local and server-side, for both live and playback modes
Channels: channel and channel visual groups in the resources panes in the left hand
side of live view
Playback channels: channel and channel visual groups in the resources panes in the
left hand side of regular playback mode
Tabs
Live: live view section (all secondary windows will be removed as these are only
capable of live mode) including multidisplay setup and screen contents buttons
Playback: if disabled, regular playback tab will be hidden (users still can jump to
playback via instant playback)
Sequence Explorer : sequencing mode (advanced footage investigation)
Smart Search: search based on motion
Alerts: application notifications
Library: library tab with exported files (if disabled, users will still be able to export
snapshots and video clips)
Reports: heatmaps and reports based on VCA/software counters
Video Wall: video wall management for Ganz CORTROL Global servers (users will
still be able to send resources to the video wall directly)
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External Services: LPR, Face Recognition, and other external or third-party
modules operating via HTTP API
Data Sources: investigation tab for the text received from data sources
Access Control: third-party integrations of access control software
Menu buttons
File: if disabled, corresponding main menu item will be hidden, preventing user from
using its contents
Edit: if disabled, corresponding main menu item will be hidden, preventing user from
changing application settings
View: if disabled, corresponding main menu item will be hidden, preventing user
from changing application operation modes
Tools: if disabled, corresponding main menu item will be hidden, preventing user
from accessing in-app utilities
Help: if disabled, corresponding main menu item will be hidden, preventing user
from using its contents
Connections: if disabled, server connections button will be hidden (all servers that
connect automatically will be loaded, including those prompting for the password)
Live toolbar
Multidisplay setup button: if disabled, multidisplay setup will be unavailable
(existing multidisplay settings will be dropped)
Screen contents: if disabled, user will be unable to create layouts
After saving the settings, please restart the Ganz CORTROL Client application for the changes to take effect. You
can also save the settings into a *.config file by pressing the Export... button and specifying the file name and
location for further usage of the same restriction profile on other workstations. Use the Import... option to load the
profile on these machines.
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Archive Backup Wizard

Ganz CORTROL offers an option to back up any recordings from any server manually, in the proprietary Ganz
CORTROL archive format. Video, motion information, audio, VCA data streams, as well as external serial
data can be extracted from the original archive and saved elsewhere, with an option to include the portable
player tool so that the downloaded recordings can be played on any Windows-based computer, even if it has no
Ganz CORTROL installed.
The wizard is included with any Ganz CORTROL installation, including Ganz CORTROL Console management
application and Ganz CORTROL Client application, and allows connection to local and remote servers.
The archive will be copied to the computer that has Archive backup wizard running on it. Thus, if you are
connecting to a server remotely via Archive backup wizard, the archive copy will be downloaded to your
computer from the server. As footage may be of significant size, make sure you have the required bandwidth
available.
Start the Archive Backup Wizard from the Windows Start menu: Start -> All Apps -> CBC AMERICAS, Corp. > Archive Backup Wizard (in Windows 7 and older versions, use Start -> All Programs -> software installation
folder -> Tools -> Archive Backup Wizard); alternatively, use Search to locate Archive Backup Wizard in the
programs menu.
From the Ganz CORTROL Client application, the wizard can be launched via main application menu by opening
View -> Archive Backup Wizard and choosing the server (one of the connected ones). The address of the server, and
also the username and password, will be taken from the currently configured server connection.

Using Archive Backup Wizard
First, you will be asked to log into the target server: your user account must have an administrative permission to
make archive backups plus permissions to back up footage from individual channels/channel groups. You can create
archive backups from the local server or from any remote server (login procedure is analogous to Ganz CORTROL
Console login), including individual recording servers. If you run the wizard from the Ganz CORTROL Client
application, you will not be asked to log in; instead, your configured server connection will be used.
After you log in, you will be presented with the list of available recordings, grouped by channel. Select the channel(s)
you need by putting a checkmark next to each one; specify the required time range above the channel list and click
Next.
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Choose the target time interval and required channels
Depending on the number of selected channels, their footage size, storage speed and connection latency, it may take
a few moments to retrieve the stream information. Once it is done, you will be presented with a list of streams for
each of the selected channels.
The following tracks can be backed up, depending on the channel recording settings and, therefore, stream
availability:
main video stream, substream and edge recordings
video motion information
audio stream
VCA metadata
external serial data from Data sources
Archive bookmarks and external service data (e.g., LPR/FR recognition results) are not available for backup.
Additionally, you can append the portable player tool with the copied part of the archive so that you can play the
archive without having to install Ganz CORTROL server on another machine. Guidelines on the portable player
usage are available in your Ganz CORTROL Client user guide.
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Choose data streams and include portable player, if required
Here, you also need to specify a directory for the archive to be copied to: it may be a local hard disk, a shared
network storage, or an attached USB drive. You are asked to choose an empty folder as a backup destination, so
you may need to create a new folder from the standard Select folder dialog.
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Backup progress
When ready, hit Next for the wizard to proceed with backing up the selected information. Depending on the size of
the selected archive, the backup procedure may take some time and its progress will be displayed in the wizard
window. When it is finished, you will get a confirmation with a short description of what has been done.
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Archive backup succeeded
If you wish to back up more recordings, start the wizard again and follow the described procedure once again.

Postpone Your Archive Backup
If, during the backup progress, you decide to stop it for some reason, simply hit the Cancel button in the bottom
right corner. You will then be presented with several options of how the wizard can proceed:
save the task and files: save your current backup progress and preserve the wizard state until the next time
you run it; you will be able to continue with the current backup item(s) then
save files only: leave the files that have been downloaded so far but discard the wizard settings so that the
next time you run it you will be presented with default choice
remove files: discard current backup task completely and remove the downloaded files
continue to download: go back and continue with the selected backup
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Archive backup termination options
If you have chosen to save both the task and the files, next time you start the wizard you will be reminded of the
unfinished backup job and offered to continue with it. If you click Yes to proceed with the unfinished task, it will be
started automatically right after you provide your user credentials for the server login.

Continue with an unfinished backup task
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Portable Player

Ganz CORTROL Portable Player is a standalone application designed and optimised to play back media exported
from Ganz CORTROL as well as native Ganz CORTROL archive. Original archive playback also includes the
opportunity to save snapshots and export video clips into the player own library.
Portable player can be optionally appended when you copy exported files from Ganz CORTROL Client to an external
location (burn to CD/DVD etc.), and can also be obtained from CBC AMERICAS, Corp.. This application can be
transferred to any Windows machine that does not have Ganz CORTROL installed and used for viewing archive
recorded by Ganz CORTROL and video clips exported from such an archive.

Portable player interface
Player main menu, located in the upper right corner, gives you the following options:
File
Add file/folder/archive: append a file or directory contents to the current playback list
(Channels section on the left)
Exit: close the application
Edit
Settings: overlay, language and media export preferences (see below for details)
Help
About: software version and legal information

Settings
Application settings are pretty much alike Ganz CORTROL Client settings and include the following:
General tab: change the language and set the default setting for aspect ratio here
Viewport overlays: choose what overlay elements and controls appear on top of the video
Library: set the directory where exported files will be stored (for clips and snapshots exported from the
proprietary archive playback mode)
Snapshots export: set snapshot export defaults here
Video export: set defaults for video clip export here
Do not forget to restart the player when you change the interface language. Keep in mind that all opened
channels are discarded upon application restart.
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Media Playback
This mode allows single-channel playback of video files exported earlier from Ganz CORTROL archive via
Ganz CORTROL Client or portable video player.
Go to the main menu File -> and choose Add File to load a single video file, or Add Folder to open the contents of the
whole directory. The selected files will appear on the left-hand panel, under Channels. Note that only valid Ganz
CORTROL files will be appended to the playlist. Use the Search field on top of the panel to filter the displayed items.
Double-click or drag and drop any channel onto the main viewing area to start playing it. Buttons below the
timeline let you control the process.

Media file playback
Controls, from left to right:
time: current playback position/total file duration
play: click the buttons to make them work
jump to beginning
jump 24hrs, 1hrs, 10min, 1min or 10sec back
go back frame by frame
regular play button
go forward frame by frame
jump 24hrs, 1hrs, 10min, 1min or 10sec forward
jump to the very end
speed: drag the blob or use the plus and minus buttons to change playback speed (from 0.5 to 128x)
Controls that overlay the video are similar (less functionality present) as for normal Ganz CORTROL Client
playback, including digital PTZ.
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Native Archive Playback
The Proprietary Archive Playback tab allows you to access and play back the native archive recorded by Ganz
CORTROL. The archive structure must be integral (intact) for the player to be able to read the data, i.e., if you copy a
part of the archive to a different machine, make sure to copy all index files (all those not having an MDAT suffix).
We strongly recommend that you only use the whole archive in order to maintain its integrity and guarantee normal
data playback.
Portable player is only able to play the archive that is currently not used by Ganz CORTROL. If a folder
containing the archive is configured to be used as archive destination on a Ganz CORTROL server, you will get
a warning dialog box and the player will not access such a directory. This is to ensure that the player does not
interfere with recording.
Thus, you will be able to play either directories that are currently not used as storage (e.g, disks coming from
other servers) or local storage directories while Ganz CORTROL server is stopped.
To add an archive to be displayed, click main menu File -> Add archive and locate a directory where Ganz
CORTROL archive is stored (default path is DISK:\CBC AMERICAS, Corp.\Archive Files). All contained tracks will
be listed in the Resources panel on the left.

Native archive playback
This mode is multichannel, meaning that you can use layout templates from the Resources section on the left
and fill them with channels for them to be played pack simultaneously.
Controls and timeline elements here are essentially the same as for regular Ganz CORTROL Client playback,
including video export, digital PTZ and motion search but excluding some things like bookmark search and
multichannel snapshot export.

Library
This section displays the contents of the folder that has been set up as destination for the files exported from
Portable Player. You can change the path via main menu Edit -> Settings -> Library tab. Both snapshots and video
files are shown, and the list is retained when the application is restarted.
Section functionality is almost the same as that of the Library section of Ganz CORTROL Client, except for the file
export to CD/DVD and other external media.
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